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1 PURPOSE OF THIS MANUAL 

This manual describes the policies, procedures and controls to be exercised in accounting and 
reporting the financial activities of the Diocese of the West.  It is designed for use by the Treasurer 
of the Diocese of the West and Assistant Treasurer to facilitate compliance with policy and ensure 
consistent procedures are followed.   
Diocesan business computer user ids and passwords are found in the Appendix, which is contained 
in a separate file from that of this manual.  The Appendix may not be posted on any computer or 
internet site. A separate file Access, contains userids and passwords for bill paying purposes. 
A copy of this manual must be kept on the Diocesan Web page and hardcopies in the Offices of 
the Treasurer and the Assistant Treasurer.   

2 DESCRIPTION OF THE DIOCESE OF THE WEST 

The Diocese of the West, Orthodox Church in America was established as a religious non-profit 
501c(3) corporation in 1975 under the laws of the State of California.  The Diocese of the West is 
a body of the Orthodox Church in America and consists of all parishes, mission parishes, missions, 
chapels and institutions of that Church within that Geographical territory defined by the Holy 
Synod of Bishops of the Orthodox Church in America as constituting the Diocese of the West.  
Currently, the Diocese has parishes in the states of California, Oregon, Washington, Montana, 
Colorado, Nevada, Arizona, and Hawaii.   
The Diocese is administered by the canonically recognized Bishop of San Francisco, currently His 
Eminence, The Most Reverend Archbishop BENJAMIN.  The Diocesan Council is The Board of 
the Directors. The principal office of the Diocese is in the City and County of San Francisco, 
California at 1520 Green Street 94123. 
 

3 GENERAL RESPONSIBILITIES 

Treasurer of the Diocese of the West – the Treasurer is accountable for the maintenance of this 
manual and shall provide a hard copy for review by the Diocesan Council and Diocesan Auditing 
Committee upon request.  (Policy per DC Mtg. 10/10/2017).  The Treasurer shall also provide a 
copy of this manual during the review of the financial records by an external auditor. 
The Treasurer and the Auditing Committee - responsible for ensuring that accurate records are 
maintained, and the specified internal controls are in place and exercised.  Cost effective internal 
controls have been selected to minimize expense to the diocese yet reduce the possibility of the 
misuse of funds.  
The Finance/Budget Committee – assists the Diocesan Council in its oversight responsibilities 
relating to fiscal management.  It shall prepare and recommend approval of an annual operating 
budget; regularly review financial results; ensure the maintenance of an appropriate capital 
structure; oversee the management of organization-wide financial assets.  It shall regularly review 
this Accounting Procedures Policy and Procedure Manual, make recommendations for policy 
revisions, and present revised versions of this manual to the Diocesan Council for approval. 
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4 THE TREASURER OF THE DIOCESE OF THE WEST   

4.1 Duties 
According to the bylaws of the Diocese (21 October 2010), the Treasurer of the Diocese of the 
West shall be responsible for:   
 

• the receipt, safekeeping, and proper disbursement of all money and other property of the 
Diocese entrusted to his care, according to the direction of the Diocesan Council 

• rendering a statement at the Diocesan Assembly and at such other times as may be 
requested by the Diocesan Council.  The annual statement shall be audited and certified 
as provided by these Bylaws 

• shall maintain, or have maintained, such account books, records, and procedures as 
necessary to fulfill the needs of accountability to Diocesan authority and to such legal and 
civil authorities or entities with legally constituted interest in Diocesan financial affairs.  
Such accounts, records and procedures shall remain available for inspection by any 
member, at any time during normal hours, upon reasonable notification 

• performing such other duties as may be imposed by law, the Articles of Incorporation, 
these Bylaws, and decisions of the Diocesan Council 

 

4.2 Qualifications 
As specified in the bylaws, the Treasurer is appointed by the Diocesan Council from among its 
numbers. The term of office shall be for one year. 
The Treasurer must understand accounting principles and must be able to use QuickBooks 
accounting software to record financial transactions and create reports.  The Treasurer need not be 
a professional accountant, but non-profit bookkeeping experience is preferred.  The Treasurer must 
also be able to use the following applications:  Google Backup & Sync (gDrive); Microsoft Word, 
Excel, and Outlook; Adobe Acrobat Pro; Gmail. This position requires approximately 30 to 40 
hours of work per week to properly exercise all responsibilities.  
  

5 THE AUDITING COMMITTEE 

5.1 Duties 
The Diocesan bylaws state that: 

The Auditing Committee shall be composed of three members, one clergy and two lay, 
preferably with accounting or bookkeeping experience, who shall periodically review the 
work of the Treasurer and of the financial aspect of the work of the Diocesan Council.  The 
committee shall also audit and approve the annual financial report of the Diocesan Council 
before it may be mailed to the parishes.  The Auditing Committee shall audit the financial 
records of all Committees of the Diocesan Council and all auxiliary Diocesan organizations. 

The Audit Committee shall periodically review this manual and verify that the procedures, policies 
and controls specified are followed.  The Audit Committee shall make recommendations as needed 
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to ensure that the specified controls are adequate for the current operating environment.  They shall 
also oversee the financial reporting process and the hiring and performance of the external auditors.  

5.2 Qualifications 
The Auditing Committee shall be composed of three members, one clergy and two lay, preferably 
with accounting or bookkeeping experience. 

6 FINANCIAL RECORDS & BUSINESS CONTINUITY 

6.1 Paper Records 
Current year paper records are stored by month in hanging folders near the treasurer’s desk at 
(insert current address).  All blank checks are in the possession of the Treasurer. The only items 
not scanned and stored on the diocesan Gdrive are the receipts submitted to substantiate expenses 
paid with the Diocesan Credit Card or to substantiate reimbursable expenses.  The Treasurer is 
responsible for the maintenance of paper records according to the Document Retention Policy 
provided in the Appendix of this manual.  Prior year audited financial paper records are stored in 
the Diocesan Office. 
All electronic Diocesan financial documents are stored on a Google Drive (Backup & Sync) 
account, treasurer@dowoca.org, in a folder named Diocesan Treasurer Files. Access may be 
shared as needed.  The Treasurer and Assistant Treasurer(s) require access.  Local copies may be 
found on computers owned by those with whom the files are shared.  The Treasurer’s local folder 
structure is backed up daily to a Carbonite internet backup server.  
 

6.2 Continuity of Business  
 
If the Treasurer cannot fulfill the duties of the office, the Assistant Treasurer or other person, 
appointed by the Diocesan Council and skilled in the use of QuickBooks, can assume those 
duties.  Any current year paper files from the treasurer’s office can be shipped to San Francisco 
by contacting the (enter contact information). 
 
Financial activity is maintained in a QuickBooks Premier Plus Nonprofit Edition 2018 data file. 
Both the Treasurer and Assistant Treasurer have access to the data file located on a network 
computer hosted by Cloudvara.   The computer may be accessed from a MAC or PC.  The 
usernames/passwords for this computer and data file may be found in the Appendix to this 
manual.  The Diocese also subscribes to QuickBooks Enhanced Payroll Support.  Paychecks for 
a given year are automatically created with the proper withholding and can be submittal to Intuit 
for processing by the Treasurer/Assistant.  Federal and California State tax reports are generated 
in QuickBooks and e-filed from QuickBooks.  Oregon reports are created by the 
Treasurer/Assistant directly on the Oregon Department of Revenue web site. 
  

mailto:account,%20treasurer@dowoca.org
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7 SOFTWARE APPLICATIONS 

 

7.1 Email  
 
The email address for the treasurer function is treasurer@dowoca.org.  This is a Gmail business 
email account managed with the email address chancery@dowoca.org.   The email received by 
treasurer@dowoca.org is organized into folders for purpose of efficiently processing the mail.  
This email address should be accessible by both the Treasurer and the Assistant Treasurer. The 
account has a contact list in which contacts may be associated with several different groups.  
This facilitates sending emails to groups of people (Parish Treasurers, DOW Clergy, DOW 
Parish, DOW Business, Monthly Financial report, Finance Committee, Audit Committee, 
Synaxis Board, St Peter the Aleut Board).   
 

7.2 Computer Backup 
 
Carbonite is the backup software licensed by the Diocese for use on as many desktops as needed.  
The Treasurer and Diocesan Admin are the administrators for the software. The administrator 
dashboard can be accessed by using the log on information found in file Access. 
 

7.3 Adobe Acrobat PRO DC 
This software allows the user to create PDF documents, edit them, create forms, and assemble 
one PDF document from several other documents.  It also allows a user to e-sign documents. The 
administrator, treasurer@dowoca.org, administers and assigns new licenses.  
 

8 DIOCESAN FINANCIAL REPORTING  

Internal financial statements shall be prepared monthly by the Treasurer, distributed to members 
of the Diocesan Council and posted on the Diocesan website.  The financial statements shall 
include, at a minimum: 
 

• A verbal summary of the month's financial activities  
• A consolidated balance sheet showing roll-up and detail of financial position of 

operational and restricted funds as of the end of the month.  
• An Operating P&L for the year to the report date, showing roll-up detail and 

comparing actuals with what was budgeted for the entire year. 
• Balance Sheets & P&Ls for restricted funds for Finance/Budget Committee. 
• Detailed Operating P&L and Detailed Consolidated Balance Sheet for the 

Finance/Budget Committee. 
 

mailto:treasurer@dowoca.org
mailto:chancery@dowoca.org
mailto:treasurer@dowoca.org
mailto:treasurer@dowoca.org
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It is the policy of this organization to use the accrual basis of accounting that recognizes revenues 
when they are earned and expenses when they are incurred. 

9 THE CHART OF ACCOUNTS 

This section lists the current chart of accounts and account descriptions.  This section may be 
amended as new accounts are added or existing accounts are made inactive.   
 

9.1 Assets 
 
The signers on all accounts shall be the Treasurer, the Chancellor of the Diocese, the Secretary, 
and the Diocesan Hierarch. (Policy per DC Mtg. 10/12/2017). Details below will be corrected as 
signers are added and/or corrected.  Only one signature is needed on a paper check.   

 Bank Accounts 
 

9.1.1.1  QuickBooks Bank Accounts List 
 
 
Only accounts which are active at the time of the current revision are described below.  Multiple 
checking and savings accounts are indicated.  See the Attachment to this manual for account 
numbers, online user ids and passwords.  The attachment may not be posted on-line. 

 
QuickBooks Account Name Description 

 
Checking at Wells Fargo…7933 

(www.wellsfargo.com) 

 
Non-interest-bearing disbursement account for operating 
funds.  Deposits by to this account are made by the 
Administrative Assistant and Treasurer.  The signers on the 
account are the Treasurer, Mary Caetta, the Chancellor, 
Archpriest Ian MacKinnon, and Treasurer Assistant, 
Theodora Blom. 
 
 

 
Savings-Wells Fargo…2402: Short Term 
Operating Reserves 

 
A fund in the Wells Fargo Savings account for operating 
funds (Class: Operating-Operations). The signers on the 
account are the Treasurer and Chancellor.  The signers on 
the account are the Treasurer, Mary Caetta, the Chancellor, 
Archpriest Ian MacKinnon, and the Treasurer’s Assistant, 
Theodora Blom. This account is used in General Journal 
entries to offset Restricted Fund activities handled in the 
Checking at Wells Fargo account. 
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QuickBooks Account Name Description 
 
 
Savings-Wells Fargo – Board Designated 
Funds 
 

 
External Audit Set Aside 

 
Internship Set-Aside Fund 
 
Legal Set-Aside Fund 
 
Liturgical Supplies Set Aside Funds 
 
Matushki Activities Reserve 

 

 
 
Set-asides from unrestricted funds.  
 
 
Unused prior year budget is rolled over to fund balance for 
the next year (RO). 
 
Funds to be used as a stipend for a clergy intern. (RO) 
 
Funds to be used for legal expenses. (RO) 
 
Funds for Diocesan liturgical supplies. (RO) 
 
Excess funds collected in prior years for Matushki 
Activities.   
 
 

 
Savings-Wells Fargo - Restricted Funds  

 
Diaconal Training Transient Funds 
 
 
Point Reyes Loan Fund - R 

 
 
 

Mission Department Funds – R2 
 

 
 
 
Pan Orthodox Clergy Funds 
 
 
Sarah Elisabet Scholarship Fund 
 

 

 
 
 
Training fees collected and used for training expenses. (Pass 
Through/Restricted) 
 
Transient sub account for funds being moved into the 
Infinity Investment Asset account or from that account. 
 
Holds repayment on Mission Dept. Loans or other Mission 
Dept. income.  Activities tracked with class 
Restricted/Missions 
 
Non-diocesan funds managed for Canonical Orthodox 
Bishops on West Coast.  Archbishop Benjamin directs the 
use of the funds according to the Treasurer of the COBWC. 
 
Funds donated for scholarships 
 

 
Savings at Wells Fargo –  

 
CDs ending in 2686 and 2678 
 
 
 

 
 
 
CDs holding Mission Department funds. Interest tracked 
with the class Restricted /Missions 
 
CD holding restricted funds for the Missions Department.  
Interest tracked using class Restricted/Missions. 
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QuickBooks Account Name Description 
 

Pacific Continental Bank  
 
805 SW Broadway   Ste 780 
Portland, OR 97205 
Jason Moos (503) 542-8524 
 

 
CDs ending in 6894 and 6886 

 
 

 
CD ending in 06795 

 
 

 
 
 
 
 
 
 
 
Operating funds CDs. 
 
SEO Scholarship Fund Restricted CD (Class: Scholarships).  
Funds donated by Sarah Oftedal.  Chancellor and Treasurer 
are signers on the CDs.   
 

 
Saving at Capital One 360 
 

 
 
CDs ending in 4138, 7176, 4614 
 
 
CD ending in 5483 

 
An online DOW business account.  Composed of an 
Operating Savings account, and several Certificates of 
Deposits for unrestricted funds. Treasurer and Chancellor 
may view, withdraw, and transfer funds.  Number of 
operating savings CDs may vary from year to year. 
 
 
Holds restricted funds for the Missions Department.  
Interest tracked using class Restricted/Missions. 
 

 
Union Bank CD 
 
 

 
CD account for operating funds.  Interest tracked with 
Class: Operating/Operations-General. Chancellor and 
Treasurer are signers on the account.  Account will be 
closed when it matures on 7/31. 
 

 
East West Bank  

 
Account is managed by the Insurance Administrator 
(Archpriest Michael Regan) to collect Kaiser Insurance 
Premiums for several priests in the Pacific Central Deanery 
(PCD) and to pay the Kaiser group’s insurance premiums. 
(Class: Restricted: Kaiser) 
 

 
 

 Accounts Receivable 

9.1.2.1 Policy for Determining Parish Assembly Assessments (Obsolete) 

9.1.2.2 Policy on Loans to Parishes or Institutions 
Only the Diocesan Council may authorize a loan from Diocesan funds to a parish or Diocesan 
Institution. 
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9.1.2.3 Policy on Personal Expenses Charged on Diocesan American Express Card 
 
The Diocese acknowledges that occasionally air fare and/or car rental charges for personal travel 
may inadvertently be charged to the Diocesan American Express Card by an authorized user of the 
card.  The Treasurer will invoice that person for the amount charged in error. 
 

9.1.2.4 QuickBooks Receivable Accounts 
 

QuickBooks Account Name Description 
 

Loans from Operating Funds 
 
 

 
 

a. Tranche1 
 

 
b. Tranche2 

 
Two 5-year notes managed by the Orthodox Church 
Capital Improvement Fund. Diocese has option to renew or 
close out loan at end of 5 years. (Class: Operations – 
General).  Source of funds was operating savings. 
 
No interest/no principal due for first 24 months. The 
monthly payment =$1249.32. 
 
Interest at 3.5%. Monthly Payment = $579.96 
 

 
Loans from Mission Funds 
 

a. Loan through OCCIF 
 
 
 

b. Personal Loan  
 
 
 

 
 
A loan of 30K to OCCIF to be used as part of a larger loan 
to a church.   Current agreement is only interest is to be 
paid by OCCIF until a larger loan is formalized. 
 
 
Loan of $1,800 to assist priest in a move.  Due 12/15/2017. 

 
Parish Assessments 

 
Outstanding prior year percentage assessment. 
Class Operations-General 
 

 
Misc. Receivables 

 
Receivables due from individuals to the Diocese, ex.  for 
the repayment of personal items inadvertently charged to 
Diocesan Credit Card.  Class Operations-General 
 
 
 

 
Other Parish Receivables 

 
Non-Assessment receivables due the Diocese from parishes. 
Ex:  Background checks performed on parish non-clergy 
members by the Diocese. Class Operations-General 
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QuickBooks Account Name Description 
 

Portrait of American Saints Receivables  
 
Receivables due the Diocese for the sale of the booklet 
“Portrait of American Saints”. Class for transactions is 
Operating: Projects: Portraits of Saints 
 
 
 

 
Stewardship Pledges  

 
Stewards of the West pledges due.  Class Operating: 
Outreach: Stewards 
 
 

 
 

 Other Current Assets Accounts (Inventory)  
QuickBooks Account Name Description 

 
“Saints of America” Inventory 

 
Value of the current physical inventory at the Diocesan 
Office of the booklet “Portrait of American Saints” 
 

 

 Other Current Assets (Unrestricted/Operating Cash) 

9.1.4.1 Board Designated Funds Policy 
 
It is the policy of the Diocese of the West to treat board-designated funds as unrestricted net assets 
on the statement of financial position (balance sheet).  The activity for board-designated funds will 
be included in the P&L statement as Unrestricted Activities (Operating Funds).   
 

9.1.4.2 Petty Cash Policy 
 
It is the policy of the Diocese to maintain, if necessary, a petty cash fund at the Diocesan Office 
of $200.00.  The petty cash shall be under lock and key always.  Disbursements from the petty 
cash fund may only be made for budgeted and/or approved office expenditures. A receipt must 
accompany every disbursement.  The receipt must be signed by the person disbursing the 
reimbursement from petty cash and the person receiving the cash as a reimbursement.  Receipts 
for petty cash shall be submitted to the Treasurer at the end of every month. 
 
The Treasurer shall replenish the petty cash fund as needed.  The petty cash check shall be made 
out to the individual primarily responsible for maintaining the fund, with the word “agent” 
following that person’s name.   
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9.1.4.3 Other Current Operating Asset Accounts 
 
 

QuickBooks Account Name Description 
 
Paypal 
 

  www.paypal.com 
 
(See Attachment for login information) 

 
Account which accumulates online donations to the 
Stewards of the West.  Funds accumulated as stewardship 
donations during the month should be transferred to 
Wells Fargo Checking the following month. 
(Class:Operating:Stewards) 
 

 
Petty Cash  

 
Not an active account.  The amount of Petty Cash 
provided to the Diocesan Office in San Francisco for 
which no expense receipts have yet been received.   
 

 
Undeposited Funds 

 
The value of checks recorded as income but not yet 
deposited into the checking account.   
 

 

 Other Current Asset Accounts (Temporarily Restricted Assets) 

9.1.5.1 Temporarily Restricted Funds Policy 
 
Funds donated to the Diocese of the West for a specific purpose shall be treated as a Temporarily 
Restricted Fund in any asset account if the total amount donated is expected to be disbursed for 
that purpose.  These funds are not available to the Diocese for ordinary operating expenses. 
Activity of those funds shall be reported on separate P&L statements and assigned a QuickBooks 
Subclass of Restricted for P&L reporting purposes. 
 
If funds collected exceed the requirements of the specified purpose, then the Diocesan Council 
shall designate, if possible with donor consultation, to what purpose the remaining funds shall be 
disbursed.   

9.1.5.2 Temporarily Restricted Accounts 
 

Account Name Description 
 
Infinity Financial  
 

https://www.investor-connect.com 
 
(See Attachment for login information.) 
 

Contact:  James Simos - (866) 682-3888 
1624 Franklin St Ste. 1001 
Oakland, CA 94612-2824 

 

 
An investment account to hold funds originally from the sale 
of the Point Reyes property.  Funds are invested in bonds or 
bond funds, CDs and an interest earning Government Cash 
Fund. Funds are used for loans to parishes or institutions.  
The Diocesan Council must authorize all expenditures from 
these funds.   
 
All activities within the fund are designated with the 
QuickBooks Class:  Restricted/Pt Reyes Fund. 
 

http://www.paypal.com/
https://www.investor-connect.com/


Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 17 of 124 

Account Name Description 
 
Goldstar Trust – LV Bonds  

 
Funded from Pt Reyes Fund and used to purchase bonds for 
the mortgage reduction efforts of St Paul the Apostle 
Church in Las Vegas.  (Class: Restricted – Pt Reyes Fund) 
 
Account will be closed when all bonds are redeemed. 
 

 
Loans from Pt. Reyes Funds  

 
Current active loans made from funds received from the 
sale of the St. Eugene Hermitage property in Point Reyes in 
2008.  Class Restricted: Pt Reyes Fund 

 
 
LCBA Missions Savings 
 

Certificate #92 
 
Loyal Christian Benefit Association 
PO Box 13005 
Erie, PA 16514-1305 
(800) 420-1470 

 
4.5 % interest-bearing annuity account at Loyal Christian 
Benefit Society.  Seeded from a donor directly to support 
Missions.  The signers on the account are:  His Grace 
Archbishop Benjamin; the Chancellor, Archpriest Ian 
MacKinnon; the Mission Director, Archpriest Matthew 
Tate.  No additions may be made to this account. Monthly 
paper statements are mailed to the Diocesan Treasurer. 
 
All activities within the fund are designated with the 
QuickBooks Class:  Restricted/Missions 
 

 

 Other Assets Accounts 
Account Name Description 

 
720 Duboce House 
 

720 Duboce Ave 
San Francisco, CA  

 
Shows equity invested from Pt Reyes Fund in 
the San Francisco property as a result of paying 
off the mortgage for a parish that was closed.  
The House is owned by the parish corporation 
called The Synaxis of the Theotokos Church. 
 

 Fixed Assets (Land and Buildings) 
 
.   

Account Name Description 
  

 
Furniture and Equipment 

 
Capitalized and depreciable equipment, including 
capitalized repairs and improvements, costing in excess of 
$1,000 individually.  Furniture and equipment for use in the 
Diocesan Office. Useful life exceeds one year.   
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9.2 Liabilities 
 
 

 Liability Accounts 
 

Account Name Description 
Accounts Payable Accrued obligations due to the Diocese’s vendors 
 
Credit Card at Chase…8183 

 
Accrued obligations to Chase Bank Credit Card  
 

 

 Other Current Liabilities Accounts 
 

Account Name Description 
  
Direct Deposit Liabilities  

Obligation accrued to the Diocese when a direct deposit of 
payroll has been scheduled.   Salary obligations are 
incurred a day before the payment will actually be paid.    
Enhanced QuickBooks Payroll makes all the journal 
entries automatically.  
 

 
Payroll Liabilities 

 
Payroll obligations due to outside agencies  
 

 
Federal Income Tax Withholding 

 
Obligation to IRS of Federal Income Taxes withheld from 
employee paychecks. 
 

 
Medicare:Company 

 
Obligation to IRS of Employer portion of Medicare Tax 
for employees.  Only applicable for non-clergy employees. 
 

 
Medicare:Employee 

 
Obligation to IRS of Medicare Taxes withheld from 
employee payroll. Only applicable for non-clergy 
employees. 
 

OCA Pension  
Obligation of the Diocese to the OCA Pension Fund of 
withheld and deferred income for clergy employees. 
 

                      
 OCA Pension: Company 

  
Obligation to the OCA Pension Fund for Mandatory 
employer contribution of 8% of gross income of all clergy 
employees. One account per clergy employee. 
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Account Name Description 
                

OCA Pension: Employee 
 
Obligation to the OCA Pension Fund for the clergy 
employee contributions of 6% withheld from pay. One 
account per clergy employee. 
 

               
 Social Security 

 
Obligation to the IRS for Social Security Taxes (Only 
applicable for non-clergy employees) 
 

                            Social Security: Company  
Obligation to the IRS for the Company match of withheld 
employee social security. 
 

                            Social Security: Employee  
Obligation to the IRS for Social Security withheld from 
Employee pay. 
 

               
 State Withholding CA 

 
Obligation due to the State of California for withheld state 
income taxes for non-clergy living in California.  
 

 
OR State Withholding 

 
Obligation due to the State of Oregon for withheld state 
income taxes for non-clergy living in Oregon. 
 

 
OR Unemployment tax - Company 

 
Obligation of company to pay full unemployment tax for 
non-clergy employee living in Oregon. 
 

 
OR WBF – Company 

 
Obligation of company to pay into the Workers Benefit 
Fund. 
 

 

9.2.2.1 Policy on the classification of clergy as employees 
 
Ordained clergy shall be considered as employee for Federal Income Tax purposes.  Ordained 
clergy shall be issued W2 forms if any portion of their compensation is not a housing allowance.  
The withholding of Federal or State Income Taxes is voluntary on the part of both the parish and 
the clergy.  W4 forms must be submitted annually in order for the Treasurer to withhold these 
taxes.  The Treasurer shall not withhold Medicare or Social Security taxes from the pay of clergy 
employees, nor shall the parish be obligated to pay the company portion of these taxes. 
 
If voluntary withholding of income taxes is to be performed, income taxes should not be computed 
on the housing allowance portion of clergy compensation. 
 

9.2.2.2 Policy on participation in the OCA Pension Plan (TBD) 
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9.3 Equity Accounts  
 

QuickBooks Account Name Description 
  
 
Unrealized Gains and Losses 

 
Tracks unrealized gains and losses from all investments.  
Each investment vehicle has its own account as a 
subaccount under this major category. 
 

 
Retained Earnings 

 
At end of fiscal year, the net income for the year is added 
to Retained Earnings. 
 

 
Operating Net Assets 

 
At beginning of next fiscal year, the sum of prior year 
Operating Net Assets and current retained operating 
earnings. 
 

 
Restricted Net Assets 

 
At beginning of nest fiscal year, the sum of prior year 
Restricted Net Assets and current retained restricted 
earnings. 
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9.4 Income 
 
The Diocese of the West has two major sources of income, parish assessments and donations.  
Some donations are given to be used within the diocese and others may be collected by the 
diocese to be forwarded on to a specific charity. 
 

 Income Accounts 
 
The major income categories and descriptions are listed below.  New subcategories may be 
added, but the Class used for transactions in subcategories inherit the Class of the highest-level 
category.  Subcategories may also become inactive over time.  
 

Account Name Description 

  
Lights-on Income Income to support the general operations of the Diocese.  

Class: Operating 
Book Sales  

Sales of Portrait of American Saints Booklet.  Class:  
Operating: Projects: Portrait of Saints 
 

Parish Assessments   
Assessments paid by parishes. Class: Operating: 
Operations-General 
 

Gifts in Kind - Goods  
Value of donated goods, non-cash gifts and contributions, 
donated inventory.  Class:  Operating: Operations-General 
 

Operating Investment Income  
Dividends & Interest Earned by unrestricted savings, CDs, 
and investments. Class:  Operating: Operations-General 
 

Outreach (Stewards of the West)  
Income from Stewards of the West donations and pledges 
to support outreach programs.  Class:  Outreach: Stewards 
 

General Stewardship Donations Stewards of the West Donations.  

Pledges  
Income from Pledges to Stewards of the West 
 

  
Restricted Income Temporarily Restricted Income 

 
Diaconal Training Fees  

Direct Charity Donations Donations remitted to the Diocese for payment to a specific 
charity.  Class:  Restricted/Direct Charity 
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Account Name Description 

  
Project Mexico 

 
Project of building homes and supporting an orphanage in 
Mexico. 
 

Gobezie Goshu Home Home providing food and education for children in 
Ethiopia 

St Petersburg Children’s  
Hospice 
 

 
Orphanage for sick children in St Petersburg Russia  

Kaiser PCD Income  
Premium payments to Pacific Central Deanery Kaiser 
group health insurance. 

Liturgical Fund Income  
Donations for Liturgical Items.  Class:  Restricted: 
Liturgical Items. 
 

 Mission Board Income  
Temporarily Restricted Income for Missions 
 

CD and Savings Interest 
OCCIF Loan Interest    

 
Interest received on Mission Restricted funds. Class:  
Restricted: Missions. 
 

Donations for Missions  
Donations for Missions. Class:  Class:  Restricted: 
Missions. 
 

LCBA Annuity Interest  
LCBA annuity fund interest.  Class:  Class: Restricted: 
Missions. 
 

   Mission Deanery Retreat  
Fee income for Mission Deanery Retreat. Class:  
Restricted: Missions. 
 

St Andrew Distribution  
Distribution of income from St Andrew Fund.  Fund is 
administered by the OCA. Class:  Restricted: Missions. 
 
 

Music Department  
Donations directed to the Music Department.  Class:  
Restricted: Music 
 

Pass Through Income  
Directed donations to funds not belonging to the Diocese of 
the West. 
 

Misc  
Other pass through Restricted income.  Class:  Restricted:  
Pass Through 
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Account Name Description 

  
Pan Orthodox Clergy Fund  

Pan Orthodox Group fees for meetings and bank interest. 
Archbishop directs payment from fund.  Class:  Restricted:  
Pass Through 
 

PT Reyes Fund Income 
 

 
Dividend and interest income as well as gains realized on 
Pt Reyes Fund investments.  
 
 

Loan Interest  
Interest received on loans made from Pt Reyes fund 
money. Class:  Restricted: Pt Reyes 
 

Bank Savings Interest  
Interest on Pt Reyes funds in savings accounts. Class:  
Restricted: Pt Reyes 
 

Investment Interest & 
Dividends 

 
Interest and Dividend income on Pt Reyes Fund 
investments.  Class:  Restricted: Pt Reyes 
 

Realized LT & ST Capital 
Gains 

 
Realized Long Term and Short-Term Capital Gains on Pt 
Reyes Fund investments. Class:  Restricted: Pt Reyes 
 

Scholarships  
Donations targeted for seminarian scholarships.  Class: 
Restricted: Scholarships. 
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9.5 Expenses 

 Lights on Expenses  
Expenditures that are necessary for maintaining the existing critical business operations of the 
Diocese of the West.  Paid from unrestricted funds.  

9.5.1.1 Payroll Expenses  
 
Expenses incurred to pay the officers of the diocese as well as department chairs and other 
support personnel. 

9.5.1.2 Employee Benefits 
 
Full-time clergy in the OCA must be provided with health insurance unless they have other 
arrangements (for example, coverage under their spouse's policy). (12_06_2013 +Benjamin). 
 
 

Account Name Description 
 

  
Employee Benefits 
 

Clergy and Non-Clergy Employee Benefits.  
Class:  Operating-Administration 
 

Benefits for Diocesan Hierarch 
 

 

Diocesan Hierarch OCA Pension 
 

The Orthodox Church in America 
Pension Plan 
PO Box 675 
Syosset, NY 11791 

 

Mandatory Diocesan contribution (8% of 
compensation) paid to the OCA Pension Plan.  
Invoices received monthly by email and due 
before the 20th of the month. 
 

Health Insurance  
 

Pacific Central Deanery 
331 Danbury Cir 
Vacaville, CA  95687-3365 

Monthly premiums payable to The Kaiser 
Health Plan (PCD).  Policy managed by 
Archpriest Michael Regan for the Pacific 
Central Deanery. Only one letter received per 
year stating the monthly premiums. 
 

LCBA Life Insurance 
 

Loyal Christian Benefit Association 
PO Box 13005 
Erie PA 16514-1305 

 

Loyal Christian Benefit Association (LCBA).  
Premiums paid quarterly. 

Benefits for Other Employees  
Admin. Assistant Pension OCA Pension  
Chancellor Pension OCA Pension 
Director of Missions Pension OCA Pension 
Asst. Treas. Oregon Workers Benefit Payment into Oregon WBF for Oregon resident 
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Account Name Description 
 

Fr. Barnabas Health Insurance 
 

Bradley W Day 
 

Auto payment by Chase Credit card of 
premiums to Kaiser. 
 

  

9.5.1.3 Gross Wages 
 

Account Name Description 
  

Asst. Treasurer Salary Class: Operating: Administration. 

Diocesan Hierarch Salary  

Housing – Admin Asst Housing for Administrative Assistant 

Housing - Chancellor  

Housing – Mission Director  

Housing -  Diocesan Hierarch 

 

 

 

9.5.1.4 Payroll Taxes  
 
The Diocese shall withhold Medicare and Social Security Taxes for non-clergy employees only. 
Currently on one employee qualifies for these taxes.  Workers Compensation covers all 
employees, including those issued 1099s. Class:  Operating: Administration 
 
 

Account Name Description 
  

Medicare Taxes Medicare Taxes – Diocesan Share  
 

  
Social Security Tax Social Security Taxes – Diocesan Share 

 
  

Oregon Unemployment Company paid – 0.026% of wages 
 

  
Oregon Workers Benefit Fund Company paid - 0.028% of hours worked 

 
  

California Workers Compensation Workers Compensation Insurance Paid by Diocese.  
Policy carried by Guide One Insurance 
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9.5.1.5 Stipends (Clergy & non-Clergy Self-Employed Status) 
 
Stipends (not classified as housing allowances) paid to clergy and non-clergy workers who report 
or will report this income to the IRS as self-employment income.  Class:  Operating: Operations-
General  
 
 

Account Name Description 
  

Bishop’s Stipend Stipend paid to Bishop Daniel 

Deans Stipends  
Monthly stipends paid to 5 of the 6 Deans.  Class: 
Operating: Administration.  (The Dean of the 
Mission Deanery is also the Director of Missions and 
is paid a salary instead.) 
 

Treasurer Stipend Monthly fee for bookkeeping paid to Church 
Bookkeeping Services 

9.5.1.6 Professional Fees 
 
 

Account Name Description 
  
 Class:  Operating: Operations-General 

CPA Fees Fees paid to CPAs for Financial Reviews and Advice 
 

Legal Fees Fees paid to Lawyers and Law Firms 
 

Notary Public  Fees paid to Notary Public 
 

Investment Fees Fees paid for investment account management 
  

9.5.1.7   Office Expenses 
 

Account Name Description 
  
 Class:  Operating: Operations-General 
  

Background Checks Cost of background checks of clergy and church 
workers.   

Bank Charges  
Bank Charges for Returned Checks, wire fees, Online 
Banking through QuickBooks, and other bank fees. 
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Books & Publications Disbursements for business-related books and 
publications. 
 

Church Law & Tax Support 
Program 

Includes monthly electronic newsletters and online 
access to Christianity Today Website as well as 
Church and Clergy Tax Guide. 
 

Study Books Books used by clergy for group study 
  

CA Non-Profit Filing Fee  
Filing Fee paid to California to update non-profit 
status. Due every 2 years. 
 

  
Fort Ross Registration  

Registration Fee for use of Fort Ross Chapel and 
Grounds for Fourth of July Annual Celebration 
 

  
Desktop/Laptop Maintenance Backup, Anti-virus, malware software. 
  
Office Services Copying, shredding services, general printing  
  
Office Supplies   

Checks, tax forms, desk supplies, printer toner and 
ink, printer paper and stationery. 
 

  
Telephone/Internet  

Office communication expenses 
 

Diocesan Hierarch Cell Phone  
Mobile phone expenses paid to Verizon for 
Hierarch’s cell phone. 
 

Green St Land Line  
Basic local and long-distance phone. 
 

  
Green St Internet Access  

  
               Treasurer basic mobile plan 2 GB mobile phone plan 
  
Postage   

Expenses for stamps, Stamps.com, FedEx, and USPS 
mailings. 
 

QuickBooks Software  QuickBooks Software and Payroll Service. Internet 
hosting of data file, and Wells Fargo charge for Bank 
Feeds to QB. 
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9.5.1.8   Travel 
 
Airfare, lodging, meals, tolls, parking, and other fare expenses when traveling for any of the 
purposes listed below.  Classes used are:  Travel: Airfare, Car Rental, Fares, Parking, Misc., 
Gasoline, Mileage, Lodging, and Meals. 
 

Account Name Description 
  
  

Bishop Travel Bishop Daniel’s expenses for travel 
 

Chancellor’s Advisory Committee Travel Member travel expenses.  Can be split with Council 
Meeting travel. 
 

Chancellor’s Travel Archpriest Ian MacKinnon travel expenses 
 

Clergy Educational Travel/Tuition  
Council Meeting Travel Expenses of council members to attend meetings of 

the Diocesan Council (DC).  Exception: clergy 
members are not reimbursed for DC meetings held at 
a Diocesan Assembly. 
 

Deans’ Meeting Travel Meeting travel expenses for Deans. 
 

Diocesan Hierarch Travel Expenses for Archbishop BENJAMIN travel 
 

Metropolitan Council Travel Expenses for two representatives to attend meeting in 
Syosset twice a year. 
 

Seminary Visit Expenses for two clergy to travel to seminaries and 
interview students/prospective DOW clergy. 
 

Travel for Financial Audits Expense for travel of Internal Audit Committee and 
Treasurer to site of annual Internal Audit.  Also, any 
travel expenses for external review. 
 

Travel of Other Diocesan Business Expenses for travel not fitting above categories. 
 

Visiting Clergy Travel Expenses for non DOW clergy to visit diocese. 
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9.5.1.9   Facilities and Equipment 
 

Account Name Description 
 Class:  Operating: Operations - General 

Office Equipment  
Expense for office equipment not capitalized.  (Under 
$1,000) 
 

 Property & Liability Insurance 
 

Attn: Centralized Receipts 
GuideOne Insurance 
PO Box 14599 
Des Moines, IA 50306-3599 

 

 
Director and Officer Insurance.  Policy carried by Guide 
One and paid annually. 
 

 

9.5.1.10 Clergy and Parish Resources Expenses 
 

Account Name Description 
  
 Class:  Operating:Operations - General 

Clergy Retreat  

 Clergy Pre-Assignment Assessment.  
Expense for professional assessment of clergy prior to 
assignment within the Diocese of the West.  Limit 
$600.00 per year. 
 

 Deanery Activities  
Expenses for each deanery for deanery-wide specific 
activities. 
 

Liturgical Supplies  
Expenses for DOW supplies as well as reimbursements 
to parishes for liturgical supplies requested by Bishop 
for use at parishes and missions 
 

 OCA Clergy Assistance Program  
Annual Fee paid to OCA for Clergy access to 
counseling program 
 

Vocations  Deacon and Sub Deacon Training Expenses 
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9.5.1.11 Department of Communications 
 

Account Name Description 
  
07_Department of Communications Class:  Operating: Operations - General 

” American Saints” Publication  
Expenses for the publishing of an edition of the Portraits of 
American Saints booklet.   
 

Web Site Hosting & Domain Name fees  
Annual expense for provider of web site server and 
services 
 

Web Site Designer Fees  
Stipend paid to designer and maintainer of Diocesan Web 
Site. 
 

 
 
 

9.5.1.12 Diocesan Assembly 
 

Account Name Description 
  
  

Class:  Operating: Diocesan Assembly 
 

Airfare Expenses for airfare to the assembly for Guests of the 
Diocese.    
 

Badge Holders & Nametags Self-Explanatory 
 

Banquet Self-Explanatory.  Not always held. 
 

Council Meeting Dinner Expenses of dinner for DC members and guests prior to 
Assembly 
 

Food  
Expenses for breakfast, lunches, refreshments, etc as 
required by the assembly schedule. 
 

Honorarium Honorarium for guest speaker. 
 

Hotel Rooms Expenses for Hotel Rooms for guests of the Diocese 
 

Postage, Copying, Mailing, Printing  
Expense for any Assembly Announcements, Registration 
Materials, Delegate Report Book printing, handouts. 
 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 31 of 124 

Account Name Description 
Projection System Expenses of purchasing or rental of projection equipment 

 
Transportation  

Expenses of the hosting parish to transport guests to the 
assembly. 
 

 
 

9.5.1.13 OCA Expenses 
 
 

Account Name Description 
  
OCA Expenses Class:  Operating: Operations - General 

AAC Non-Travel Expenses For Booth, Observer Fees, and other expenses 

All American Council Assessment OCA assessment for the All-American Council (every three 
years) 
 

Central Church Support Current year support.  34% of parish assessment income is 
paid to the OCA by the 17th of the month. 
 

OCA Liturgical Donation Annual OCA Liturgical supplies assessment 

Prior Year Support Catch up Support owed to the OCA for prior year, based on year-
end income from parishes. 
 

  

 
 

9.5.1.14 Special Events 
 

Account Name Description 
  

Fort Ross Registration and Fees Expenses to reserve park for annual July 4th 
celebration.   
 

Pan Orthodox Activities  
Class: Operating: Operations – General 
Expenses for Pan Orthodox Activities attended by 
or hosted by the Diocesan Hierarch 
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 Outreach Expenses  
 
Expenses paid from unrestricted funds to support activities of missions, youth, charity outreach, 
and seminarians. 
 

9.5.2.1 Charities Department  
 
Expenses are budgeted for a given year, but there are occasions when another need arises.  All 
payments must be authorized by the Director of Charities. 
 
 

Account Name Description 
  
Department of Charities Class:  Operating: Outreach: Charities 

Clergy Assistance Expenses for assistance to specific clergy. 

Discretionary Fund  
Expenses directed to be paid by the Chairman of the 
Department of Charities. 
 

Gifts Charitable Gifts 
 

Gobezie Goshu Home for Elderly in 
Ethiopia 

Diocesan Donations to the Gobezie Goshu Home 
 

Project Mexico Donations to Project Mexico 
 

Raphael House (Portland) Diocesan Donations to Raphael House in Portland 
 

              St Petersburg Hospice Donations to St Petersburg Hospice in Russia 
  

 

9.5.2.2 Department of Education 
 
There is currently no Chairman of the Department of Education. 
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9.5.2.3 Department of Missions  
 

Account Name Description 
Department of Missions  

Class: Operating: Outreach: Missions 
 

Mission Board Meeting Expenses Self-explanatory 

Mission Director Travel  
Transportation, Lodging, and Food expenses incurred by 
the Director of Missions when visiting Mission parishes. 
 

Mission Priest Support 
 

Misc. Expenses 
 
Mission Deanery Retreat 
 
Mission Priest Travel  
 
Stipends as Housing Allowance 
 
 
 
Stipends – not declared as 
Housing Allowance 

Material and personal support given to mission priests 
 
 
 
 
 
Travel expense for a mission priest, as approved. 
 
Payments sent to mission priests specified by Director of 
Missions.  See policy Payments to Mission Priests.  This 
line item is available for mini-grants of less than $5,000. 
The Diocesan Treasurer can declare a priest’s stipend as 
housing allowance, if they declare it by the end of prior 
year.  
 

Mission Parish Support 
 

 
Parish Items Storage 
 
Stipend to Parish  
 
 
Supplement to Mission 
Director’s Parish 
 
 

Material support given to mission parishes  
 
Payment for cost of long or short-term storage of mission 
items 
 
Stipends paid to a mission parish for them to pay visiting 
clergy. 
 
Payments to the Mission Director’s parish during 
prolonged absence from parish while traveling on diocesan 
business. 
 

Moving Expenses Relocation expenses for a new priest to a mission.  
 

Supply Priest Travel Reimbursement to a priest who provides occasional 
services to a mission parish. 
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9.5.2.4 Department of Stewardship 
 

Account Name Description 
  
Department of Stewardship Class:  Operating: Outreach: Stewards 

Online Donation Fees Fee to PayPal for Donations received from Diocesan Web 
Site 

Appeal Preparation for mailing Expenses for the paper and copying charges, envelopes, 
and labels for mailing two appeals per year. 

Postage for Appeals  Postage expenses for the mailing of the appeals and 
responses to donations. 

Uncollectable Pledges Write off of delinquent pledges to the Stewards of the West 

 
 

9.5.2.5 Youth  
 

Account Name Description 
  
Youth  

Expenses for youth and youth retreats by Deanery.  Class:  
Operating: Outreach: Youth   
 

Diocesan Youth Project  

Discretionary Spending Spending for any other youth activity per Diocesan 
Council. 
 

Desert Deanery Requests made by Igumen Daniel Brum 

Mission Deanery Requests made by Archpriest Matthew Tate 

Pacific Central Deanery Requests made by Archpriest Michael Anderson 

Pacific Northwest Deanery Requests made by Archpriest John Pierce 

Pacific Southwest Deanery Requests made by Archpriest Lawrence Russell 

Rocky Mountain Deanery Requests made by Archpriest Anthony Karbo 
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9.5.2.6 Non-Department Outreach Expenses  
 

Account Name Description 
  
               Intern Program  

Costs associated with new priests serving in the Diocese.  
Expenses are usually in the annual budget.  Approval of 
expenses needed by Director of Missions or Chancellor. 
Class:  Operating: Outreach: Intern Program 
 

Music Dept  
Class:  Operating: Outreach: Music.  Expenses budgeted 
and/or approved by the Chair of the Department of Music.  
  

Seminarian Financial Aid  
Assistance to Seminarians.  Class:  Operating: Outreach: 
Seminarian Aid. 
 

Matushki Activities  
Expenses for activities for wives of clergy.  Class: 
Operating: Outreach: Matushki Activities. 
 

 
 
 

9.6 Temporarily Restricted Expenses 
 
Temporarily Restricted Funds are held within several Bank Accounts as well as Current Asset 
Accounts as described in Section 8.1.  The following is a summary of the allowable uses of those 
funds.   
 

Account Name Description 
  
  

Point Reyes Fund Expenses 
 

Bank charges and CD penalties, investment fees, realized 
losses, payouts to missions or institutions. 
 
Approval of expense from these funds is given to the 
Diocesan Council.  Class:  Restricted: Pt Reyes Fund. 
 

Designated Direct Charities Earmarked for Charities is an account in the Wells Fargo 
checking account.  Used to track income and expenses 
to/from charity funds.   
 
Payout of designated direct charity funds should be done 
within the calendar year of the donation.   
 
One expense subaccount per specified charity.  Line items 
created as needed.  Class: Restricted: Direct Charities: 
Charity Name 
 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 36 of 124 

Mission Board Expenses Disbursement for Mission Board expenses such as the 
Deanery Retreat expenses or mission assistance specified 
by the Director of Missions.  Bank and/or investment 
charges.   Class:  Restricted: Missions.   
 

Music Fund Expenses Class:  Restricted: Music 
Scholarship Funds Expenses Payment of scholarships. Class Restricted: Scholarships 

 
 

Liturgical Item Expense Payment of funds donated for liturgical items. 
 

Kaiser PCD Expense East West Bank Charges and payment to Kaiser of the 
group premium. Class:  Restricted: Kaiser 
 

Pass Through Expenses Payout of funds as directed by ABB to cover cost of 
Orthodox Clergy meetings. Class:  Pass Through: Misc. 
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10 FINANCIAL POLICIES 

10.1 Opening an Asset Account  
 
Checking, Savings, and CD accounts may be opened by the treasurer after authorization by the 
Diocesan Council.  That authorization shall be documented in the minutes of the meeting of the 
Council.  The motion for authorization shall specify the signers on the account.  A minimum of 
two signers shall be designated for any asset account with the Chancellor of the Diocese and the 
Treasurer being signers, at a minimum.  Checks shall only require one of the signatures.  
Statements shall be downloaded on-line by the Treasurer and stored with the monthly financial 
records after the account has been reconciled. 

10.2 Account Balance Policy 
 
No single account shall have a balance in excess of the FDIC insured limit ($250,000 in 2013) for 
any extended period of time.  The Treasurer shall consult with the Finance Committee as to 
whether new accounts should be opened and how funds should be allocated among the accounts. 

10.3 Clearing Account Policy 
 
Clearing accounts within the checking account shall be funded from the appropriate temporarily 
restricted fund when funds must be disbursed by check.  These accounts should be zero at the end 
of each month. 
 

10.4 Use of Diocesan Credit Cards 
 
The Diocesan Council shall designate the authorized users of the Diocesan Credit Card. 
 
Authorized users of the Chase Credit Card shall submit to the Treasurer receipts for all expenses 
over $25.00 charged to the Chase Credit Card.   
 
The Treasurer shall send each authorized user a copy of their monthly statement and request 
verification and classification of the charges and the forwarding of all outstanding receipts.   
 
The Treasurer shall notify the cardholder of any missing receipts.  If receipts have been lost, then 
the Treasurer shall note this on the credit card statement next to the charge and attach any email 
stating that the receipt has been lost.   
 
All receipts will be attached to each authorized user’s monthly statement and stored with the 
financial records for the month in which the credit card is paid.   
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Note the tax implications on the use of a Diocesan Credit Card, from Richard R Hammar, Church 
and Clergy Tax Developments in 2005: 
 
 “Corporate credit card. Many employers provide corporate credit cards to executives and other employees. The difference between the rank 
and file credit card accounts and those maintained for executives is generally the method of reimbursement. Top level executives are permitted to use the 
card at will. A monthly statement may be mailed directly to the employer and the account may be paid in full without the submission of a business expense 
report. Lower level executives are generally required to submit an expense report and are reimbursed for business related expenses. Personal expenses 
paid on behalf of executives are taxable fringe benefits that should be included in wages. The determination of whether the corporation has an accountable 
plan should be made at the beginning of the examination. If executives are not required to substantiate that the expenses charged to the corporate credit 
card were for business expenses, the reimbursement is considered to have been made under a nonaccountable plan and the entire reimbursement is 
taxable to the executive, and constitutes wages for employment tax purposes.” 

10.5 Payment of a vendor 
 
The Treasurer shall enter all routine invoices into QuickBooks when received.  These invoices 
shall be paid by the due date.  All persons requesting reimbursement for expenses shall be treated 
as a vendor.  Stipend and Seminarian scholarship payments shall be handled as payments to 
vendors.   No invoice will be received for these payments, but authorization for payments should 
be on file.  Receipts for approved and budgeted expenses must be submitted to the treasurer.    
 
The Diocesan Council must approve all unbudgeted expenses before they are incurred or paid.   
 

10.6 Parish Percentage Assessment Policy – effective January 1, 2016 
 
PURPOSE 

This policy defines the financial obligation of parishes and missions to The Diocese of the West 
and to The Orthodox Church in America.   
 
SCOPE 

a. This policy applies to all missions and parishes in The Diocese of the West (DOW). 
This policy describes the objectives of the DOW as it moves from 2 distinct methods of 

parish support of the diocese and The Orthodox Church in America (OCA) that are 
currently in force, to a single percentage giving method for the support of both. 

This policy replaces the policy for computing the Diocesan Percentage Assessment (DPA). 
 

REFERENCES  

b. Bylaws of the Diocese of the West, Section VIII, #16 
Percentage Assessment Program, 10 Oct 2002 
 

POLICY STATEMENT 

Parishes shall remit a percentage of their monthly Eligible Income, to the DOW.  The DOW, 
in turn, shall remit 34% of diocesan assessment income to the OCA.   
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Parish treasurers shall calculate their monthly Eligible Income based on the following 
Formula:   

TOTAL GROSS INCOME minus  
CAPITAL CAMPAIGN CONTRIBUTIONS (Building Fund), plus 
DONOR RESTRICTED CONTRIBUTIONS, plus 
CHARITABLE EXPENSES, plus 
PASS-THROUGH INCOME 

 
POLICY IMPLEMENTATION 

 
This policy shall be implemented over a three-year period.  The initial parish percentage shall 
be effective on January 1, 2016.  Thereafter, the percentage shall be adjusted up or down by 
at least .5% each year until the targeted parish percentage is reached in 2019. 
The percentage that shall be applied to the monthly Eligible Income beginning January 1, 2016 shall 
be: 
 

a. 14% & 13% - for parishes currently assessed near these levels  
b. 12% & 11% - for select mature parishes 
c. 10% - for established missions (approximately 3+ years) 
d. 10% to 6% - ‘out of plan’ levels for special-needs Parishes & Missions  
e. 4% - for New Missions (under 3 years) 
f. 0% -  for struggling Missions (under 3 years) and startups 

 

The percentage that shall be applied to the monthly Eligible Income beginning January 1, 2019 shall 
be: 
 

a. 12.5% - For all Parishes 
b. 10% - For all established Missions 
c. 10% & 6% - ‘out of plan’ levels for special-needs Parishes & Missions 
d. 4% - for New Missions (under 3 years)  
e. 0% - for startups 

 
The financial obligation of diocesan parishes and missions to the Diocese of the West and 
the OCA shall be satisfied by compliance with this policy.   
 

DEFINITIONS  

Gross Income – All forms of income received by the parish (e.g., donations, tithes, pledges, or 
dues), except stocks, bonds, and in-kind donations. Also includes NET income from bookstore, 
candle stand, fundraising and rental activities.  
Funds received from a loan are not considered as part of gross income.  
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Capital Campaign Contributions – contributions to the parish for the acquisition of land and      
buildings for worship and fellowship.   
 
Donor Restricted Contributions – contributions to the parish for the acquisition of donor 
specified items to beautify the church.   Any contributions to the parish for specific items or 
activities.   Donor contributions for a charitable purpose. Pay-as-you-go donations for specific 
construction expenses. 
 Although a parishioner might donate funds for utilities, repairs, or other operating expenses, 
these donations may NOT be considered Donor Restricted Contributions under this policy.  
  
Charitable Expenses – Expenses paid out for a charitable purpose over and above the amount 
collected as Donor Restricted Contributions. 
 
Pass Through Income – Sisterhood or fellowship donations to the parish.  Income, other than 
charitable donations for external entities, that is not used to pay parish expenses. 
 
RESPONSIBILITIES 

c. Diocesan Council 
1) Receive and act upon, if necessary, compliance issues brought to its attention by the 

Treasurer and/or Finance Committee 
2) Review the effect of this policy on Diocesan income and the support of the OCA. 
3) Initiate revisions to this policy, as needed. 

d. Finance Committee 
1) Establishes transitional parish percentage assessment as the program evolves 
2) Specifies the Special Needs Parishes and Missions 
3) Processes parish/mission percentage appeals submitted by the Dean of the parish  
4) Monitors the percentage assessment program 
5) Monitors the impact of the program on parishes  
 

e. Director of Missions 

1. Monitors the impact of the program on missions 
2. Establishes percentage for a new mission and the date percentage will begin to apply 
3. Determines the financial training needs of missions.  
4. Recommend percentage adjustments for missions with special problems. 

f. Diocesan Treasurer 
1) Coordinates and implements policy in a consistent manner. 
2) Supports and trains parish treasurers on this policy and other financial matters. 
3) Remits percentage assessment to the OCA on a monthly basis 
4) Records and monitors the collection of monthly parish assessments based on the 

assigned parish percentage. 
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5) Reconciles amount of annual assessment against the required parish annual 
income/expense report. 
 

g. Diocesan Dean 
1) Confers with parish rectors when assessments are not remitted in a timely manner. 
2) Reviews any parish appeals and forwards those requiring action to the Finance 

Committee. 
 

h. Parish Treasurer 
Computes the parish assessment and remits that assessment to the Diocesan Office 
before the end of the following month.   

10.7 Receipt of Funds 
All invoice payments and donations should be mailed to the Diocesan Office in San Francisco:   

Diocese of the West, 1520 Green St., San Francisco, CA 94123-5102 
All checks received in the mail shall be immediately endorsed.   See procedure in Section 10 for 
processing receipts. 
 

10.8 Employees -  Classification of Clergy as Employees 
 
Ordained clergy, who do not claim part or all of their compensation as housing allowance may be 
considered as independent contractors and will be issued Form 1099.  All other clergy shall be 
considered salaried employees for Federal Income Tax purposes. See Section 14.7.3 for 
instructions on how to prepare their Form W2. 

10.9 Employees -  Classification of Non-Clergy as Employees 
Non-clergy, who are paid to perform work for the diocese, shall be considered regular exempt 
employees.  They shall be issued a hiring contract and provided with a list of their roles and 
responsibilities.  See Section 14.7.3 for instructions on how to prepare their Form W2. 
 

10.10 Payment of Invoices for Professional Fees 
 
The Treasurer shall pay invoices for fees that have been budgeted or for fees that have been 
approved by the Diocesan Council prior to the incurring of the fee for services. 
 

10.11 Payment for Background Checks 
 
Local parishes pay for background checks on every Reader they recommend for tonsure, and for 
anyone who is to become a Sub-Deacon.  The Diocese of the West pays for the background 
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checks on those ordained as Deacons or Priests within the Diocese as well as on all Deacons and 
Priests who transfer into this Diocese. (4/12/2011 DC minutes) 
 

10.12 Payment of Expenses for Office Supplies 
 
Disbursements may be made by the Treasurer or Administrative Assistant for Office Supplies that 
are accompanied by a receipt.    If the supplies are purchased with the Diocesan credit card, the 
purchaser must retain the receipt for the Treasurer; otherwise, the purchaser will be invoiced by 
the Diocese for the expense. 
 

10.13  Travel Policy 
 

1. Introduction 
 
It is the policy of the Diocese of the West (DOW) to reimburse travel expenses of those clergy 
and laity who are conducting business on behalf of the diocese.  The diocese strongly encourages 
travelers to use travel discounts and accumulated mileage when making their travel 
arrangements.  Travelers seeking reimbursement should incur the lowest reasonable travel 
expenses and exercise care to avoid impropriety or the appearance of impropriety.  
Reimbursement is allowed only when reimbursement has not been, and will not be, received 
from other sources.  All business-related travel paid with DOW funds must comply with 
expenditure policies. 
 

2. Authorization and responsibility 
 
Some clergy and laity are authorized to travel by virtue of the office they hold.  These travelers 
include members of the Diocesan Council, Deans, department heads and some committee 
members.   The Diocesan Budget specifies the annual travel budget for these travelers and the 
Finance/Budget Committee oversees those budgets on a monthly basis.   The Treasurer will 
approve reimbursement based on the office the traveler holds and the purpose of the travel.   
 
Anyone who does not hold any of the above positions must verify that their planned travel is 
eligible for reimbursement before travel arrangements are made.  In the latter case, the request 
for reimbursement must be approved by the Finance/Budget committee and the Treasurer 
notified of the approval. The individual may not approve their own travel.   
 
The Treasurer, with consent of the Finance/Budget Committee, may withhold reimbursement if 
there is reason to believe that an expenditure is inappropriate or extravagant.   
 

3. Personal funds 
 
Travelers who use personal funds to facilitate travel arrangements will not be reimbursed until 
proper documentation is submitted.   
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4. Vacation in conjunction with business travel 
 
In cases in which vacation time is added to an approved business trip, any cost variance in 
airfare, car rental or lodging must be clearly identified on the Travel Reimbursement Request 
Form.  The DOW will not prepay any personal expenses with the intention of being “repaid” at a 
later time, nor will any personal expenses be reimbursed.   
 

5. Per Diem Rate 
 

At this time, the DOW will not use a Per Diem allowance.  
 

6. Policy Implementation 
 

Requests for reimbursement of out-of-pocket travel expenses prior to travel are to be submitted 
on a Travel Expense Report Form. The Treasurer may issue a prepayment for airfare, rental 
vehicles, conference registration fees and cash advances.  The treasurer must receive the Travel 
Expense Report Form, the supporting receipts and/or invoices and travel approval prior to 
issuing a reimbursement check. 
 

7. Permissible PREPAID travel expenses 
 

A.  Airfare.  
 

 Travelers are expected to obtain the lowest available airfare that reasonably meets business 
travel needs.  An e-ticket receipt/statement or an Internet receipt/statement is required.  The 
receipt must show the method of payment and indicate that payment was made. 
 
Travelers are encouraged to book flights at least 30 days in advance to avoid premium airfare 
pricing.  First-class tickets are not reimbursable.  Coach class or economy tickets must be 
purchased for domestic flights.  A higher priced coach ticket cannot be purchased for a 
subsequent upgrade in seating.  An airline complimentary upgrade to first class is acceptable, but 
the fact that it is complimentary should be noted on the airline receipt.  A business class ticket 
may be purchased at the discretion of traveler on flights exceeding 5 consecutive hours excluding 
layovers. 
 
B. Rental Vehicles.  The DOW will pay for approved use of an economical rental vehicle. 
 
C. Conference registration fees.   

 
 

Conference registration fees, including business-related banquets or meals that are part of the 
conference registration can be prepaid directly by the Diocese of the West.   
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D. Travel Charged to the Diocesan Credit Card 
 
Travelers who are authorized to use a diocesan credit card may charge travel expenses in 
advance of travel or while traveling.  A Travel Expense Report Form is not required for 
travel charged to the diocesan credit card.   
 
The Treasurer will email a statement of the traveler’s charges after the statement closing date 
(the 9th of the month).  The traveler must reconcile their statement with receipts substantiating 
the expenses on the statement.   The traveler must write the trip purpose and the nature of each 
expense legibly on a printed copy of the statement. Expenses for meals must include, if 
applicable, the names of the people sharing the meal with the traveler.  If receipts are not 
routinely issued by a vendor for a particular expense and the expense is less than $50.00, the 
traveler must indicate “no receipt issued”.  The traveler will be invoiced for all other Credit Card 
Charges greater than $25.00 and not supported by receipts.   
 
In addition to those travel expenses that may be prepaid listed above, the following travel 
expenses may also be charged to the diocesan credit card. 
 
E. Car Rental 
 
The Diocese of the West (DOW) authorizes the rental of the most economic vehicle available.  
In certain circumstances, larger vehicles may be rented.  The rental agreement/receipt must 
clearly show the date and the point of departure/arrival, as well as the total cost.  Drivers must 
adhere to the rental requirements, and restrictions must be followed.   
 
When vehicle rentals are necessary, the DOW encourages travelers to purchase collision damage 
waiver (CDW) and loss damage waiver (LDW) coverage.  The Diocese will reimburse the cost 
of CDW and LDW coverage.  All other insurance reimbursements will be denied.  
 
Drivers should be aware of the extent of a coverage (if any) provided by his or her automobile 
insurance company for travel that is business or not personal in nature.  
 
Travelers are strongly encouraged to fill the gas tank before returning the vehicle to the rental 
agency to avoid service fees and more expensive fuel rates. 
 
F. Lodging 

 
The cost of overnight lodging (room rate, tax, tips, and internet/wireless fees) will be reimbursed 
to the traveler if the authorized travel is 45 miles or more from the traveler’s home or primary 
worksite.   The DOW will reimburse lodging expenses at reasonable, single occupancy or 
standard business room rates.  When the hotel or motel is the conference or convention site, 
reimbursement will be limited to the conference rate.  If reimbursement is for more than the 
single room rate, the name of the second person must be included.   
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G. Personal Meals 

 
The DOW will pay for the traveler’s personal meals taken during approved business travel.  
Receipts for meals, including tips are required. 
 
H. Business Meals   

 
The DOW will pay for business meals. Original itemized receipts and the name of those 
participating in the meal are required.  
 
I. Gasoline 

 
Original receipt required.    
 
J. Parking 

 
Original receipts are required for parking fees (including airport parking) totaling $25.00 or 
more.  The lodging bill can be used as a receipt when charges are included as part of the 
overnight stay.   
 
K. Tolls 

 
Original receipts are required for tolls totaling $25.00 or more.  
 
L. Miscellaneous transportation 

 
Original receipts are required for taxi, bus, subway, metro, ferry and other modes of 
transportation if costs are $25 or more for each occurrence. 
 
M. Post-travel Reimbursement 
 
It is the responsibility of the traveler to accumulate and save all receipts for a single trip and 
include them with a single request for reimbursement. 
 
Requests for reimbursement of out-of-pocket travel-related expenses that include a mileage 
reimbursement or for which there is for more than one receipt must be submitted by email to the 
Diocesan Treasurer with a Travel Expense Report Form (see related document) and scanned 
receipts attached.).   
 
If there will be only one receipt for a trip, it may be scanned and attached to an email with a note 
indicating the purpose of the travel and the nature of the expense.    
 
All forms and notes along with receipts may be mailed to the Treasurer or the Diocesan Office.  
Scanned copies of receipts are acceptable.    Requests for reimbursement must be submitted to 
the Treasurer within one month of the trip. Reimbursement of travel expenses is based on 
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documentation of reasonable and actual expenses supported by the original or scanned image of 
itemized receipts.   
 
Post-travel reimbursements that may be paid by the DOW in addition to those above are:  
 
a.  Automobile (personally owned- domestic travel)  

 
A valid driver’s license issued within the United States and personal automobile insurance are 
required for expenses to be reimbursed.  Drivers should be aware of the extent of coverage (if 
any) provided by his or her automobile insurance company for travel that is business or not 
personal in nature.   
 
Reimbursement for use of a personal automobile is based on the current IRS mileage rate for 
business.  Starting point and ending point of the trip as well as total miles must be indicated on 
the Travel Reimbursement Form. 
 
A trip reimbursement may not include a reimbursement for Gasoline AND mileage. 
 
b. Conference Registration Fees  

 
If not prepaid, the Diocese will reimburse fees, business related banquets, and meals. Receipts 
are required. If the conference does not provide a receipt, then a cancelled check, credit card 
slip/statement or documentation that the amount was paid is required for reimbursement.  
Entertainment activities such as golf outings and sightseeing tours will not be reimbursed.     
 
Registration fees paid directly by an individual will not be reimbursed until the conference is 
completed.   
 
c. Non-reimbursable Travel Expenses.   

 
The following will NOT be reimbursed by the Diocese. 
 

● Airline club memberships 
● Airline upgrades 
● Business class for domestic flights or first class for all flights. 
● Commuting between home and the primary work location. 
● Costs incurred by traveler’s failure to cancel travel or hotel reservations in a timely 

fashion. 
● Evening or formal wear expenses 
● Haircuts and personal grooming 
● Laundry and dry cleaning 
● Passports, vaccinations and visas when not required as a specific and necessary condition 

of the travel assignment. 
● Personal entertainment expenses, including in-flight movies, headsets, health club 

facilities, hotel pay-per-view movies, in-theater movies, social activities and related 
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incidental costs.  Travel accident insurance premiums or purchase of additional travel 
insurance. 

● Other expenses not directly related to the business travel. 
 
The Travel Expense Report Form is an Excel file which automatically calculates expense 
totals by day and by expense category.  If miles are entered, it calculates the mileage 
allowance using the current year IRS mileage allowance. 
 

Account Name Description 
  

Bishop Travel Travel for Bishop Daniel 
  
  

All American Council  
Disbursements paid for transportation, food, and lodging 
for the Archbishop and Administrative Assistant to attend 
the All American Council. 
 

Chancellor's Advisory Committee  
Disbursements paid for transportation, food, and lodging 
expenses for the members of the Chancellor’s Advisory 
Committee to attend meetings. 
 

Chancellor's Travel  
Disbursements paid for transportation, food, and lodging 
for the Chancellor to perform duties assigned by the 
Archbishop 
 

  
Council Meeting Travel  

Disbursements paid for transportation, food, and lodging 
for the members of the Diocesan Council, Deans, and 
Department Heads to attend a Diocesan Council Meeting.  
Diocesan Assembly travel expenses for non-clergy 
members of the Diocesan are put in this category. 
 

Dean's Travel  
Disbursements paid for transportation, food, and lodging 
for the Deans to attend a meeting of the Deans.  Also covers 
a Dean’s travel within his Deanery if approved by the 
Bishop.  
 

Diocesan Hierarch Travel  
Disbursements paid for transportation, food, and lodging 
for the Diocesan Hierarch for parish visits and Pan 
Orthodox meetings. 
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Account Name Description 
Metropolitan Council  

Disbursements paid for transportation, food, and lodging 
for the Diocesan representatives to the Metropolitan 
Council to attend meetings of the Metropolitan Council in 
Syosset, NY. 
 

  
Seminary Visit  

Disbursements paid for transportation, food, and lodging 
for the Director of Missions and one Dean to visit OCA 
Seminaries once a year. 
 

Travel for Auditing Function  
Disbursements paid for transportation, food, and lodging 
of Internal Auditors and Treasurer 
 

  
  
Travel for Diocesan Business  

Disbursements for other authorized travel.  Approval of 
Archbishop required. 
   

Visiting Clergy Travel Covers travel cost for visitors to the Diocesan Office 
 
 
 

10.14 Deanery Activity Expenses 
 
An amount of $1500 is allocated annually for this expense beginning in 2013.  Funds will be 
directed to each deanery when requested by its Dean.   
 

10.15 Payment of Department of Communications Expenses 
 
Office and publication expenses, and Web Site provider receipts and/or invoices must be presented 
by the Chair of the Department of Communications to the Treasurer for payment.   
 

10.16 Diocesan Assembly 
 
Parishes are responsible for the payment of transportation and lodging of their delegates to the 
Diocesan Assembly. Clergy members of the Diocesan Council are not reimbursed by the Diocese 
for their transportation to the Diocesan Council meetings held immediately before and after the 
Diocesan Assembly.  The cost of their transportation and lodging is the responsibility of the clergy 
member’s parish.   
 
 
Delegates make their own hotel and transportation reservations. 
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Non-clergy members of the Diocesan Council will be reimbursed for transportation and lodging 
for the Diocesan Assembly and the pre- and post-assembly council meetings. 
 
The hosting parish shall submit receipts for expenses incurred for hosting the Assembly. 
 
Retired Bishops and priests are not required to pay the observer fee. (Policy per DC Mtg. 
10/10/2017) 
 

10.17 Stipend Payments to Mission Priests 
 
The Mission Board shall determine which mission priests shall receive stipends, the amount of the 
stipend, and the length of time for the stipend. 
 
Stipend amounts will normally be $500 for the first year, $400 for the second and $300 the third. 
The stipend can also be higher in the first year, or it can stay at the same level for several years at 
the discretion of the Mission Dean and the Mission Board. The Mission Dean can make temporary 
changes between MB meetings if needed. This action will be submitted to the MB for confirmation 
of continuance. 
 
The Mission Dean shall submit a budget request for stipends and other Department of Mission 
Expenses to the Diocesan Budget Committee for the following year.   The Mission Dean is not 
required to ask for Diocesan Council approval of the manner of distribution of the stipends.  If the 
amount budgeted for stipends is insufficient, then the Mission Dean must request the increase from 
the Diocesan Council.    
 
The Mission Dean shall provide the Treasurer of the Diocese with a current list of those priests 
who should be receiving stipends and the dates when those stipends shall change or cease.  The 
Mission Dean shall provide the Treasurer with current contact information for all priests receiving 
stipends. 
 
This line item is available for mini-grants of less than $5,000.  Any request for such a grant will 
be evaluated and authorized by the Mission Board.   
 

10.18 Reimbursement of moving expenses 
For pastors who move in 2018 through 2025, they will no longer be able to deduct their moving 
expenses, nor with their church be able to reimburse these expenses on a tax-free basis. 
 

10.19 Payment of Department of Missions Expenses 
 
The Treasurer may disburse funds for Mission Department Travel substantiated by receipts and 
within the approved budget.   Written requests for payment of unbudgeted expenses by the Director 
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of Missions will be accepted.  The Director of Missions is expected to manage the budget for 
Missions.  Those expenses will be paid as long as there are no budget over-runs.    
 

10.20 Source of Funds to Pay Missions Expenses 
 
The above expenses shall be routinely paid from budgeted unrestricted funds.  They will not be 
paid out of the Temporarily Restricted Missions Funds in the LCBA annuity account or the Wells 
Fargo savings account. 
 

10.21 Policy on Management of Charities Department Budget and 
Expenses 

 
The Charities Department shall submit a budget to the Diocesan Finance Committee for charities 
and institutions to be supported by the Diocese out of unrestricted funds.  The Charities Department 
shall approve all disbursements to individuals and shall submit such approval to the Treasurer prior 
to the payment of any expenses for that individual or the writing of any check to that individual. 

10.22 Policy on Payment of Expenses for Youth 
 
The payout of allocated funds for youth by Deanery is based upon the request of the Dean of that 
Deanery. 
 

10.23 Policy on Payment of Expenses for Appeals 
 
The Treasurer shall reimburse all substantiated expenses for the mailing of appeals  
 

10.24 Disbursement of Financial Aid to Seminarians 
 
The Archbishop or Chancellor shall inform the Treasurer which seminarian will receive financial 
aid.  A seminarian is eligible for financial aid if he is attending a seminary with the intention of 
becoming a priest.  The amount of assistance is $1,000 per seminarian. 
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11 OVERVIEW OF FINANCIAL PROCEDURES 

These procedures are followed by the Administrative Assistant and the Treasurer and/or assistant 
to the Treasurer.  The first set of procedures are organized according to their frequency of 
execution.  Most of the procedures are executed weekly, monthly or annually.  These are then 
followed by procedures that may be needed infrequently. 

12 DAILY/WEEKLY – PROCESS INCOMING RECEIPTS 

Controls for Receipts 
Receipts are almost always in the form of a check or money order made payable to The Diocese 
of the West.  Cash is rarely received and when it is, it is a donation and the amount is less than 
$5.00.  Occasionally donations will be received through Paypal. 
Donor pledge payments are payments against invoices (pledge confirmations).  Invoices are also 
sent to parishes for background check reimbursements.  Pledge statements are mailed twice a year 
and donors are notified when a pledge has been fulfilled.  The statements act as a control to mitigate 
the risk of checks not being correctly attributed and deposited.   
Stewardship donations are always acknowledged.  At the end of a stewardship year, the names of 
donors and their donor classification is posted on the diocesan web site.  The acknowledgements 
and the posting of donors’ names act as checks against donations being incorrectly recorded. 
Parish remittances are always received with a sales receipt 
The Administrative Assistant processes all receipts and deposits all funds.  A record of the receipts 
and deposits is passed on to the Treasurer who records the payments in QuickBooks. 
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12.1 Overview of Administrative Assistant Role in Processing Receipts 
 
 

 
 
         

12.2  Overview of Treasurer Role in Processing Receipts 

 

Endorse Checks 
& Record in Excel 
logfile. 

Prepare & Make 
Deposits 

Email Logfile to 
Treasurer and save a 
copy on Google Drive 

Scan Checks and post 
on Diocesan Google  
Drive (GDrive). 

Record checks 
from logfile into 

QuickBooks. 

Add/Correct 
Donor 

Information 

Generate Donation 
Acknowledgements 

Record Bank 
Deposit in 

QuickBooks 
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12.3 Endorse Receipts and Record in Log 
 
Purpose of the Procedure 
 
To assure that all checks received by the Administrative Assistant  

• are promptly endorsed 
• are handled in a matter which will prevent theft or loss 
• are properly recorded  

   
Frequency 
 
The Administrative Assistant shall follow this procedure every workday.  
 
Assumption 
 
The Administrative Assistant  

• shall use a log file in a format supplied by the Treasurer 
• an endorsement stamp has been provided by the Treasurer 
• deposit slips have been provided by the Treasurer 
• has access to the diocesan Google Drive (Gdrive). 

 
The log file is an electronic file and shall contain a record of all checks to be deposited on any 
given day. 

 
 
Main Procedure 
 

1. Open Diocesan mail and remove checks and any accompanying notes, invoices, or 
statements. Discard the envelope if the return address is known to be correct. 

2. Open an Excel log file for the next deposit.    
3. For each check received,  

a. Confirm the check is made payable to “The Diocese of the West”.  Any other 
designation is not acceptable to the bank 

b. Confirm that the amount in numbers is the same as the amount on the legal line. 
c. Record the information from the check into a line of the logfile.  Record the purpose 

of the check from the memo line or any accompanying paperwork. Discard 
accompanying paperwork, unless there is a note addressed specifically to the 
Treasurer. 

d. If this check is from an individual, confirm the name and address provided agree 
with the information in the Vision mailing list and update the mailing list, if 
necessary. 

4. Repeat from step 3 until all checks received that day have been recorded. 
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5. Scan the front of the checks and pledge cards to a pdf file.  Save to Gdrive.   
 

6. Print out log file and wrap around the checks listed in the log.  Save an electronic copy of 
the log file to the Gdrive. 

7. Store checks and any pledge cards in a locked box until checks are ready to be deposited. 
End of Procedure 
 

12.4 Prepare and Make Physical Deposit of Checks 
Purpose of the Procedure 
 
To assure that all checks received by the Administrative Assistant  

• are handled in a matter which will prevent theft or loss 
• are properly recorded    
• are deposited within one week of their receipt 

 
To assure that deposit information is systematically and promptly delivered to the Treasurer  
 
Frequency 
 
 As needed to ensure that all remittances received by the 15th of the month are logged and 
deposited by the 16th of the month.  

 
Main Procedure 
  
1. Remove the checks with their accompanying paper log file, and any pledge cards from the 

locked box. 
2. Select one batch of checks and confirm that the corresponding log file is the latest version. 
3. Use a calculator and confirm that the total amount of the checks in one batch matches the 

amount calculated in the log file (Excel Spreadsheet) 
4. Prepare the bank deposit slip(s) for the batch. 
5. Confirm that until checks have been recorded on the deposit slip. 
6. Go to the bank and make the deposit, requesting a receipt. 
7. Initial and date the deposit receipt.  Staple the deposit receipts to the log file.  
8. Keep the copy of the bank deposit slip along with the copy of the logfile on the Gdrive.  
9. Mail the log files and deposit receipts along with any pledge cards or communications in an 

envelope to the Treasurer.  
10. Create an email record of the envelope contents and email to the Treasurer. 
11. Email a copy of the logfile to the Treasurer. 
 
End of Procedure 
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12.5 Process Email  
 
Purpose 
 
To allow more than 1 person to sort and process incoming diocesan email, so that each email 
receives the proper attention. 
 
Assumptions 
 

• The treasurer and assistant treasurer have access to the email account 
treasurer@dowoca.org. 

• Any email in the inbox marked as “Read” is currently being processed.   

• When an email is opened, it will be processed the same day.   

• Any email which has been opened and which will not be processed the same day will be 
moved to the appropriate processing folder and marked “Unread”. 

 
Procedure (Sorting of unread emails) 
 
TBD  
 
 
End Procedure 
 

12.6 Record Checks in QuickBooks 
 
Purpose 
 
To properly record each check deposited. 
 
Assumptions 

• The Treasurer has received email containing the log file of deposits from the Administrative 
Assistant. 

• Parishes are identified in the QuickBooks Customer list by a numerical prefix followed by a 
city name.  This practice sorts the parishes by deanery. 

• Each parish (customer) has at least two jobs (activities) beneath the numbered customer.  For 
each parish, the jobs are: 

Parish Assessments – for parish remittances 
Name of parish - for parish stewardship donations or background checks, etc. 

• The customers were set up this way to make it easier to see at a glance all the customer 
transactions for a major financial activity. 

mailto:treasurer@dowoca.org
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• The following is the list of diocesan parishes, missions, and mission stations as of July 2017.   
 

100 Billings, MT 300 Poulsbo, WA 500 Sonora, CA 
100 Bozeman, MT 300 Seattle, WA 500 Tempe, AZ 
100 Calhan, CO 300 Tacoma, WA 500 Vancouver, WA 
100 Colorado Springs, CO   
100 Delta, CO 400 Los Angeles, CA 600 Las Vegas, NV 
100 Denver, CO 400 Oxnard, CA 600 Phoenix, AZ 
100 Littleton, CO 400 Santa Barbara, CA 600 Poway, CA 
100 Pueblo, CO 400 Santa Maria, CA 600 San Diego, CA 
200 Berkeley, CA 400 Tarzana, CA  
200 Concord, CA  700 Astoria, OR 
200 Eureka, CA 500 Ashland, OR 700 Helena, MT 
200 Fremont, CA  500 Bend, OR 700 Newport, OR 
200 Menlo Park, CA   
200 Pleasanton, CA 500 Carlsbad, CA  
200 Sacramento, CA 500 Chico, CA  
200 San Anselmo, CA 500 Culver City, CA  
200 San Francisco, CA - CSC 500 Durango, CO   
200 San Francisco, CA - HTC 500 Hesperia, CA  
200 Santa Rosa, CA 500 Hilo, HI  
200 Saratoga, CA 500 Kirkland, WA  
200 West Sacramento, CA 500 Kona, HI  
300 Corvallis, OR 500 Merced, CA  
300 Port Townsend, WA 500 Milwaukie, OR  
300 Portland, OR 500 Parker, CO  

 Record a Pledge Payment or Invoice Payment 
 
Assumptions: 
 

• The logfile shows an “S” for Stewardship in the Payment Type column or an invoice 
number in the Referenced Invoice(s) column. 

 
Procedure 
 
1. In QuickBooks, from within the Customer Center, select the appropriate customer: job for 

the check purpose.  
2. Select New Transactions/Receive Payments 
3. If there is an S in the Payment Type column and the customer has a balance, then go to Step 

6.   
4. Select one of the following receivables accounts: 

Misc. Receivables  
Other Parish Receivables 
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Portrait of American Saints Rec 
 

5. Go to step 7. 
6.  Select the Stewardship Pledges receivables account. 
7. Open invoices will appear in the window. 
8. Confirm correct date has been auto-filled.  Enter the “Payment Amount”, Ref. /Check No., 

and select “Check” for the method of payment. 
9. Check/select the invoice being paid. 
10. Select “Save & New”. 
11. If this is a final payment on a stewardship pledge, make a note on the logfile sheet as a 

reminder that a Completion of Pledge Statement should be created (See Section 11.7.2). 
12. Repeat from Step 1 for each check entry on the log file that conforms with the assumptions. 
 
End of Procedure 
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  Record Donation to the Stewards of the West 
 
Purpose:   
To record the receipt of a donation and attribute it to the correct person and account 
 
Assumptions:   

• The donation is a donation to the Stewards of the West (SOW), and not a stewardship pledge 
payment, i.e. there is an “S” in the Stewardship in the Payment Type column and no balance 
shown on the customer list. 

• Appropriate donation acknowledgment templates have been created from QuickBooks Sales 
Receipt forms. There is a form for each category described below.  The content of the 
receipt/acknowledgement satisfies the format required by the IRS for acknowledging 
donations.  

• The templates have the names 20XX Donor, 20XX Sustaining Member, 20XX Standard 
Bearer, and 20XX Torch Bearer 

Background: 
 

STEWARDS OF THE WEST 
 
The Stewards of the West (SOW) is an honorary society of leading contributors to the Diocese of 
the West of the Orthodox Church in America.  The purpose of Stewards of the West is to 
appropriately recognize those who have generously supported the indispensable outreach missions 
and charitable works of the Diocese.   
Membership in SOW encourages meaningful and consistent charitable giving in support of 
Diocesan programs and activities and effectively sustains the Diocese in the performance of its 
God given duties.  SOW members provide the Diocese of the West with the funds necessary to 
support the outreach function of the Diocese of the West. 
  

Categories of Membership 

Donor Member 
(less than $100 per year) 

Sustaining Member 
($100 per year) 

"Standard Bearer" 
($500 per year) 
"Torch Bearer" 

($1,000 per year) 
Lifetime "Beacon" 

($10,000 one-time gift, or 
$25,000 bequest by will, or charitable trust) 
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12.6.2.1 Main Procedure (A Donation Recorded on Logfile) 
 
1. Open the Customer Center.   
2. For each entry in the log file which is a donation, find and select the customer name in the 

list. If the customer does not appear, Go to Alternate Procedure: Create a New Donor. 
3. For a parish donation, select the job that shows the name of the parish.  Note the total amount 

of current year donations. 
a) Select New Transaction>Sales Receipt. 
b) Enter Stewards in the Class field. The field will auto populate with Outreach: Stewards 
c) Based on the amount of the donation check and total of previous current year donations, 

and using the table above, select the appropriate donor level template. (ex 20XX Donor)  
d) Select the Check Icon. 
e) In the Date field, enter the date the check was received in the Diocesan Office and 

indicated on the log file sheet. 
f) If this donation is from a pre-existing donor, confirm that the address displayed is the 

same as that indicated on either the accompanying pledge card or the check. (Scanned 
copies of checks and pledge cards can be found on Google Drive>Deposit Information.)  

g) In the empty unlabeled field, enter "Dear" followed by the appropriate greeting name for 
the donor, followed by a comma.  Enter the check number in the Check number field. 

h) Under Item, select the item type Stew 20XX.   
i) Enter the donation amount.  Make sure that the "to be printed" box is checked. 
j) Select “Save and Close”.   

Return to step 2 for next donation check. 
 
End of Main Procedure 
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12.6.2.2 Procedure (Donation received in PayPal) 
 
Assumption  
 

• The Diocese of the West has a PayPal account. 
 

• The Treasurer has received an email Notification of Donation Received from PayPal. 
 
1. Reply to the donor, thanking them for the donation and the stating that a formal 

acknowledgement will be sent in about a week. 
2. Print the email.  Log onto the DOW PayPal account and print the details of the donation. The 

details include the gross amount of the donation as well as the PayPal charge against that 
donation. 

3. Proceed from Step 2 d) of the Main Procedure.   Select PayPal for the method of payment, 
enter the gross amount of the donation, and use the transaction number for the check number.   

4. After Step j), select Banking/Make Deposits.  Select the PayPal donation check to deposit.   
5. From the drop-down menu, select the PayPal account in the “Deposit to” window. 
6. On the second line of the deposit, under “From Account”, enter Online Donation.  The rest of 

the field will auto-populate. Under “Pmt Method”, enter E-Check, followed by Class 
“Stewards”.    

7. Enter the amount of the PayPal fee as a negative number in the Amount field.  The total 
deposit will equal the donation amount less the PayPal fee. 

8. At the top of the screen select Print/Deposit Summary and print to the printer. 
9. Select Save & Close.   
10. Staple the email notification, the PayPal details sheet behind the deposit summary sheet and 

file in the monthly folder. 
End Procedure (Donation received in PayPal) 
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12.6.2.3 Alternate Procedure (Create a New Donor) 
 
Assumption 
 
1. QuickBooks must be in single-user mode 
 
1. Add a new customer in the customer list, last name first, in the Customer Name Field. Enter 

any contact information provided on the scanned copy of the check.  Under Additional 
Information, select Customer Type “Donor”.  Save the new customer information.   

2. If you already have opened the receipt form, you will have to re-select the customer to 
capture the new address/new customer in the Donation Acknowledgement Form. 

3. Resume at Step 3 of the Main Procedure.  
 
End Alternate Procedure (Create a New Donor)  
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 Record Parish Remittance, Charity Donation, or Other Checks 
 
Purpose 
 
To record checks which are neither Stewards of the West donations nor invoice payments. 
 
Note:  We are transitioning from using the term Assessment to the term Remittance. 
 

 
Procedure: Remittances and Other Donations 
 
1. For the customer, select New Transactions>Enter Sales Receipt. 
2. Select the correct Customer Name or Customer Name: Job in the Customer: Job field. 
3. Select the appropriate “Sales Receipt” Template.   
4. The following are the current receipt templates:  

 
• Monthly Assessment 

• Gobezie Goshu Home 

• Hospice Donation 

• Project Mexico 
 
5. Select the appropriate Class.   

• Operating: Operations-General for remittance checks 

• Restricted: Direct Charities 
6. Select Check 
7. Select an appropriate Item Name. The following are the most frequently used: 

• Assessments 20XX 

• Restrict PT: Hospice; Mexico; Gobezie; Pan Orthodox 
8. Enter the amount of the check. 
9. For charity donations only, make sure the “To be printed” box is checked. 
10. Select “Save & Close”. 
 
End of Procedure 
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 Recording a Stewardship Pledge 
 
Purpose:   
 
To record a pledge to the Stewards of the West 
 
Assumption:   

• The treasurer has received a pledge from a donor. 

• Sometimes a check will accompany the pledge card and will be a partial or even full payment 
of the pledge. The pledge (Invoice) should be entered before the pledge payment is recorded. 

 
Procedure: 
 
1. From the Customer Center, select the name of the person making the pledge. 
2. Select New Transactions/Create Invoices. 

a) Enter the donor’s name (last name, first name) in the customer: job field. 
b) Enter the class “Operating: Outreach: Stewards”. 
c) Select the Accounts Receivable account, Stewardship Pledges. 
d) Select the template, Stewardship Pledge.  “Confirmation of Pledge” will replace the word 

“Invoice”. 
e) Enter a letter-style greeting (Dear ……) in the blank box under today’s date on the 

Confirmation of Pledge form. 
f) On the pledge/invoice form, enter the date that the last pledge payment date is due, i.e. 

12/15/20XX.  
g) Enter the donation type, i.e. Pledge 20XX, the terms of the pledge and the pledge amount, 

for example:  Pledge to Stewards of the West - $100.00 annually. 
h) Select the customer message “Thank you for your pledge to the Stewards of the West”. 
i) Check the “to be printed” box. 
j) Save and close the form. 
k) Select Print Forms>Invoices with A/R account set to Receivables: Stewardship Pledges. 
l) Print the Pledge Confirmation on plain paper 
m) Sign the Confirmation of Pledge letter and email or put in regular mail. 

 
End of Procedure 
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 Recording a Refund 
 
Purpose:   
 
To record a refund from an existing vendor 
 
Assumption:   
 
All non-refund checks have been recorded. 
 
Procedure: 
 
1. Select the Make Deposits menu item. 
2. Select all the checks that will be deposited together. 
3. Select OK.  Click on the last line of the list of checks. 
4. Down arrow to add a new line to the deposit. 
5. In the Received From column, enter the name of the vendor that sent the refund.   
6. Fill in the Account Name used for the original payment and add a memo for the refund 
7. Enter the method of payment of the refund and the check number. 
8. Enter the amount of the refund. 
9. Select Save to make the deposit. 
 
End Procedure: 
 

 How to Handle a Bounced (NSF) Check 
 
1. Use the item “Bounced Check “on the first line of a new invoice for the customer whose 

check has bounced and the amount of the bounced check. 
2. On a second line of that invoice, use the item “Bad Chk Chrg” for the amount of any 

bank fees that you want to recover.  Save the invoice. 
3. Mail the invoice to the customer. 
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 Record an Principal & Interest auto-deposit from the Orthodox 
Christian Capital Improvement Fund (OCCIF) 

 
Purpose 
To record the payment of a note and allocate the principal and interest payments correctly. 
Assumption 
A deposit has been made to the Diocesan Checking account and the amount corresponds with the 
monthly amount due on a note held with OCCIF and the deposit has not been downloaded from 
the bank into QuickBooks. 
Refer to the amortization schedule for the notes Tranche 2 from OCCIF. There is a Tranche 1 
note with payments beginning in 2018. 
 
Main Procedure 
1. Receive the principal portion of the payment against the invoice for OCCIF{C}: OCCIF 

SJM Tranche 2. 
2. Open the Make Deposit window and select the principal payment.   Fill in the deposit 

date with the date the bank received the payment. 
3. On line 2 of the deposit, enter 
4.  Received from: OCCIF{C}: OCCIF SJM Tranche 2. Click OK. 

Account:  Operating Investment Income:  OCCIF Loan Interest:  Tranche 2 
Interest 

 Payment Method: E-check 
 Class:  Operations-General 
 Amount:  Interest amount as determined by the amortization schedule 

5. Save the deposit 
 
End Procedure 
 
Deposit already downloaded through Bank Feeds 
 
1.  Delete the deposit and proceed from Step 1.  
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12.6.7.1   Set Up an OCCIF Loan in QuickBooks 
 
Assumptions: 
 

• There is one customer for each OCCIF Loan Note or Tranche.  Each Loan Note or 
Tranche has been identified with either operating funds or a restricted fund. 

 
• There is an interest income line item for each note.  There is a receivables account for 

each Note or Tranche. 
 

• There is a temporary current asset account (Loans Clearing Account) which is used solely 
to create an invoice for the principal of the note.   

 
Procedure 
 

1. Select the OCCIF customer to be associated with this note. 

2. Write a check to correspond to the loan principal of the note. Expense account should be 

the Loans Clearing Account.  Make the expense billable to the OCCIF customer selected. 

3. Create an invoice for the OCCIF customer.  Select the class and receivables account for 

this note.  Use the template Loan Obligation. 

4. Select “add time/costs” and select the expense just made billable.   

5. Enter the “due date” as the date the principal is due in full.  Add some descriptive 

information about the note. 

6. Save the invoice. 

 
End Procedure 
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12.7 Record Check Deposits in QuickBooks 
 
Purpose 
 
To create a deposit equivalent to the actual bank deposit made by the Administrative Assistant. 
 
Assumptions 

• Administrative Assistant has forwarded the log file. 

• All checks listed the logfile have been recorded in QuickBooks 
 
Main Procedure 
  
1. Open QuickBooks. 
2. For Each log file, 

a) Select Banking>Make Deposits 
b) Click on the checks and any cash recorded in this log file.  Click on OK. 
c) In the next window, enter the date on which the deposit was made.  Confirm the 

correct account (usually Checking – Wells Fargo) is displayed in the “Deposit to” 
field.   

d) Click the “Print” icon at the top of the window. 
e) Select “Deposit slip and deposit summary” and click on OK.  If there are more 

than 18 entries to be deposited, select “deposit summary only”. 
f) In the “Print Deposit Slip” window, make sure “Include Cash in Total Number of 

Deposit Items” is unchecked.  Checks with the same number should be counted as 
one item.   

g) Select “Print”. 
3. Compare the deposit slip just prepared with the log file received.  Confirm that the 

amount of each deposit item in the log file is the same as that reported by QuickBooks on 
the Deposit Summary Report.  

4.  Indicate the amount is correct by placing a red checkmark next to the item in the Deposit 
Summary section of the deposit slip printed from QuickBooks. 

5. Click on “Save & Close”.  Repeat from step 2 until all log files have equivalent 
QuickBooks deposit slips. 

6. Paper clip the log file to the QuickBooks deposit summary or Deposit Slip and file them 
in the financial records folder for the month in which the deposit was made. 

7. When the Administrative Assistant mails the physical deposit receipt, staple it to both the 
logfile and deposit summary/deposit slip. 
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End of Procedure 

12.8 Generate Donation Acknowledgements and Pledge Completions 
 
Purpose 
 
To generate the appropriate acknowledgement for donations or the fulfillment of pledges 

 
Assumptions 

• All donation checks have been recorded in QuickBooks and have been deposited. 

• The receipts for the week may have included the fulfillment of a stewardship pledge. 
Frequency 
 
At least once a month. 
 

 Main Procedure (Generate Donation Acknowledgements) 
 
1. Select Reports>Memorized Reports>Customer>Recent Donations Report. 
 Items selected for this report are Stew 20XX and all the Restricted: PT Charity items. This 

report is a check against the number of forms to be printed in steps 3 and 4, just in case “to be 
printed” was accidentally left unchecked.   

2. Enter a date range that includes only the dates since donation acknowledgement were last 
printed. Print the report.  Close the report. 

3. Select File/Print/Forms/Sales Receipts.  QuickBooks will display a list of sales receipts that 
are ready to be printed. Select sales receipts for Steward’s donations or charity donations.   

4. Compare the printed report contents with the sales receipts QuickBooks expects to be 
printed.   

5. If there are more receipts in the printed report, open the sales receipts that are missing from 
the QuickBooks list and select “to be printed”.  Save and Close. 

6. Click OK.  Select Print and print to an Adobe Acrobat file saved under Donation 
Acknowledgements/SOW Acknowledgement Letters/20XX Stewardship year. 

7. Confirm that the Acknowledgement Letters reflect the correct donor category.   
a) If the category for the donor on the receipt is at a higher level than that indicated for 

the most recent donation, find the recent Sales Receipt and select the correct template 
and save. 

b) Reprint the letter after corrections have been made. 
8. Email the Adobe Acrobat file to the Chancery for His Eminence’s signature. 

 
End of Procedure 
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  Acknowledge a Fulfilled Pledge  
 
Frequency 
 
This procedure should be executed, if a note has been made on the logfile regarding a completed 
pledge. 
 
Main Procedure 
 
1. Select Reports>Memorized Reports>Customers>Status of Stewardship Pledges. 
2.  Enter a date range and print the report.  The date range should capture the pledge just 

completed.  This report can also be used to find all completed pledges within a date range. 
3. For each pledge completed (Balance = 0.0) and not acknowledged, select the customer from 

the Customer Center, then from the top menu, under Customers, select Create Statement.   
4. Use the receivables account Stewardship Pledges  
5. For the donation level achieved, select the appropriate statement template “20XX Completed 

Sustaining……., for example. 
6. Enter the appropriate statement date and date range for this pledge.  Uncheck “Do not create 

statements with a zero balance”. 
7. Click Preview and make sure the template content is current.  
8. Select Print.  Print to Adobe Acrobat and save file under Donation Acknowledgements/SOW 

Acknowledgement Letters/20XX Stewardship Year.   
9. Email the Adobe Acrobat file to the Chancery for signature by His Eminence Archbishop 

Benjamin. 
10. Repeat from Step 3 until all pledge acknowledgements have been created. 
 
End of Procedure 
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13 DAILY/WEEKLY – ENTER/PAY BILLS AND REIMBURSEMENTS 

Controls 
1. No checks may be made payable to Cash 
2. The Treasurer may pay bills only for budgeted expenses without prior authorization.   
3. On December 10, 1999, the current Treasurer, Mary Caetta, was authorized by the Diocesan 

Council to be the only required signer on checks.  Theodora Blom, the Assistant Treasurer is 
now also authorized to sign checks as well as access online banking. 

4. If the Treasurer and Assistant Treasurer are not able, the Chancellor and any other authorized 
signers on an account may also sign physical checks to pay bills.   

5. Requests for reimbursement for budgeted expenses must be accompanied by receipts.   
6. Requests for payment out of the deanery youth budget must be accompanied by receipts or 

by a written or email request from the local Dean. 
7. Expenses charged to the diocesan Chase Credit Card must be substantiated with receipts.  

These receipts must be submitted to the Treasurer when statements are received from the 
Treasurer. 

8. A check may be made payable to the treasurer only for the stipend, salary, travel, or budgeted 
office expenses substantiated with receipts. 

9. A Travel Expense form must accompany receipts for more than one travel expense item. 
 
Electronic Bill Pay through QuickBooks 
To avoid fraud and forgery of Diocesan physical checks, bills will be paid through QuickBooks 
Bill Pay where practical.  Checks are created in QuickBooks and sent electronically to the bank 
associated with the Wells Fargo checking account.  Wells Fargo then sends the information to a 
third-party bank and the check is issued from that bank, eliminating the identification of the 
banking account number with the Diocese of the West.  The password associated with QuickBooks 
Bill Pay is stored in the hard copy Appendix to this document. 
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13.1 Enter Bill from External Vendors for Budgeted Expenses 
 
Purpose 
 
To ensure that bills from external vendors for budgeted expenses are paid by the due date 
 
Assumption 
 
External vendor has sent an invoice for services and/or items 
 
Procedure  
 
1. Open QuickBooks 
2. Select Vendors>Enter Bills 
3. Enter the following information from the invoice into the Enter Bills – Accounts Payable 

screen 
1. Vendor Name 
2. Due Date 
3. Amount Due 
4. Invoice Number in Ref. No. field 

4. Select the expense account(s) for the billed expense(s) and enter the Class (of the expense – 
operating, outreach, restricted) 

5. Select Save and Close. 
6. File an electronic copy of the original vendor invoice on the Gdrive and in desk folder of 

bills to be paid. 
 
End of Procedure  
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13.2 Enter Bill for Reimbursement Request (Substantiated and/or 
Authorized)  

 
Purpose 
 
To ensure that reimbursement requests are accompanied by substantiating receipts and/or 
authorization from The Bishop, a Department Chairman, or person authorized to manage an 
activity and associated expenses. 
 
Assumptions 

• Those who may request or authorize reimbursements 
o The Diocesan Hierarch 
o The Bishop 
o The Chancellor 
o The Deans 
o Department of Communications 
o Department of Charities 
o Department of Missions 
o Department of Stewardship 

 

• Receipts substantiating the request have been received either by email. 

• Travel reimbursement requests are accompanied by a Travel Expense Report Form and 
associated receipts. 

• The treasurer has verified that the total of the receipts matches the total amount of the 
reimbursement request. 

• Authorization for the payment of the reimbursement is documented either in a letter or in 
an email. 

 
Procedure 
 
1. Open QuickBooks 
2. Select Vendors>Enter Bills 
3. In Vendor Name field, enter last name, first name of the requester. 
4. For the Due Date, enter a date 15 day in the future.  
5. In the Amount Due field, enter the total amount of the request 
6. In the Ref. No. field, enter an abbreviation for the activity or item for which reimbursement 

will be paid.  Select an existing expense account(s) for the requested expense(s) and enter the 
Class (of the expense – operating, outreach, restricted).  If the request is an unbudgeted 
expense, select and/or create the account for the unbudgeted expense. The latter should very 
rarely occur.  
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7. Select Save and Close. 
8. Staple together the receipts and authorization for the request.  For a travel reimbursement, 

save the pdf on the Gdrive, but print the Travel Expense form. 
9. File the paperwork for the request in the folder with bills to be paid. 
End of Procedure 
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13.3 Pay Bills Entered 
Purpose 
 
To ensure bills are paid in a timely manner and documentation associated with the payment are 
stored in a secure manner. 
 
Assumptions 
 
• Bills have been recorded in QuickBooks  
• Vendors have been set up as online payees 
 

 Procedure (Pay Bills Online) 
 
1. Open QuickBooks 
2. Select Vendors>Pay Bills 
3. Select Banking/Bank Feeds/Bank Feeds Center and select Yes for exclusive use. 
4. Select the bills to be paid by online payment and the account from which the bills will be 

paid. 
5. Online payment should be checked.  Confirm the correct account from which the bills are to 

be paid has been selected. 
6. Select Pay and Close 
7. In the window that opens, enter the Online Bill Pay password.  When the bills have been 

sent, print the summary of the transactions sent. 
8. Enter the check number(s) QuickBooks has assigned for the bills paid in the upper right 

corner of the printed summary. 
9. Staple the Bill Pay Summary to the supporting documentation and file in the file folder for 

the current month. 
 
End of Procedure (Pay Bills Online) 
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 Alternate Procedure (Pay Bills with a Physical Check) 
 

1. Select the bills to be paid using a paper check and account from which the bills will be paid. 
2. Select Pay and Close 
3. Place blank checks in the printer 
4. Select File>Print Forms>Checks 
5. Confirm that the number of the first paper check to be printed matches the number presented 

by QuickBooks. 
6. After the checks have been printed, sign each check and staple the voucher from each check 

to the supporting documentation. File the voucher and supporting documentation in the 
monthly folder. 

 
7. Create envelopes and mail the checks. 
End of Alternate Procedure (Pay Bills with a Physical Check) 
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14 MONTHLY TASKS 

14.1 Pay Monthly Stipends, Support for Central Church, and other 
Monthly Payments  

 
Purpose 
 
To make prompt electronic payments of monthly stipends and payments 
 
Assumptions 

• The treasurer starts the process on or about the 15th of the month prior to the date of the 
checks. 

• The treasurer issues stipend checks dated the 1st of the month for that month’s services.  
Mission priests then do not have to pay their expenses “out of pocket” in the first month of 
service.  These stipends, however, are not a reimbursement for expenses.  The payments are 
considered as payments to “independent contractors” and will be documented using 1099 
Federal Tax Forms. 

• No part of the stipend payment has been designated as a housing allowance by the Diocesan 
Council.  

• The treasurer creates the checks in QuickBooks but sends them via QuickBooks Bill Pay for 
mailing.  The treasurer should generate the checks soon enough for them to be mailed out 
and received by the first of the next month. 

• QuickBooks checking accounts are set up for QuickBooks Bill Pay 

• All recurring monthly payments are in the list of memorized transactions in QuickBooks. 

• If the first of the month is a bank holiday, the online payment date must be set in QB as the 
last day of the current month.  

 

 Procedure (Select and Send the Scheduled Transactions) 
 
1. Open QuickBooks open the List of Memorized Transactions.  
2. Go to Bank Feeds and obtain exclusive use of Feeds for the Wells Fargo Checking 

account. 
3. In the Memorized Transaction List, double-click on each non-stipend transaction due the 

1st or 2nd of next month.  Select Save and Close. 
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4. In the Memorized Transaction List, double-click Stipends – Deanery 
5. Confirm that the date displayed is the first day of next month.  If the first day of next month 

is a bank holiday, then set the date to the last working day of this month. 
6. All checks are memorized with “pay online”. 
7. Click OK and click OK again. 
8. In the Memorized Transaction List, double-click Mission Stipends. 
9. Confirm that the date displayed is the first day of next month.  If the first day of next month 

is a bank holiday, then set the date to the last working day of this month.   
10. All checks are memorized with “pay online”. 
11. Click OK and click OK again  
12. Select Banking>Bank Feeds>Bank Feeds Center. 
13. On the left side, highlight the bank account from which payments will be made. (Checking at 

Wells Fargo).  
14. Click on Send Items. 
15. Enter the PIN number (Refer to attachment to this manual.)   and click OK. 
16. When the transactions have been sent, select “Print” in the Online Transmission Summary 

Window.  Print to a local printer. 
17. Close the Online Transmission Summary Window and the Bank Feeds window.   
18. Staple all the pages of the online report together.  Write the check range in the upper right-

hand corner of the printed online transmission summary.  Write “Monthly Stipends & 
Kaiser“under the header. 

19. File the summary in the folder for the month in which the payment will be made, not the 
processing month.   
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 Procedure (Compute and Pay Monthly OCA Support) 
 
Assumptions 

 
• The diocese pays 34% of its monthly assessment income to the OCA.   

 
• Parish monthly remittances received by the 15th of the month have been recorded in 

QuickBooks.  
 

 
1. Determine the amount received since last support payment. 

 
a) Select Reports>Memorized Reports>Company OCA Computation Base.   
b) Set the period from the 16th of the prior month to the 15th of the current month.  

Filter by item: combined assessment. It should be a cash basis report.  Click OK. 
c) Collapse the report output.  Print the report as a PDF under DOW Bills and 

Receipts/OCA Computation Sheets as well as to the printer.   
d) Compute 34% of the total and write that amount on the report.  
e) Either edit and save the PDF after adding “34% of X = X “under the total on the 

report or write it on a hardcopy of the report and scan it back to DOW Bills and 
Receipts/OCA Computation. 

2. Create the payment check and select “pay online” or mail a paper check. 
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14.2 Create Monthly Paychecks and Housing Allowance Checks 
 

Purpose: 
 
To create paychecks for salaried administrative employees and clergy as well as stipend 
paychecks for mission clergy who declare some or all of their compensation as housing 
allowance.  

 
Assumptions 
 

• Direct Deposit has been set up for each salaried employee and clergy, if possible. 

• W2 forms have been filed for the prior year or will be prepared for the current year. 

• In general, administrative employees are paid on the first business day of the month for the 
prior month pay period.  Housing allowances and stipends are paid on the first business day 
of the month for that month. 

• If the salary check date for administrative employees will fall on a Saturday or Sunday, the 
check date shall be the last business day of the current month.   

• Paycheck items have been completed for each employee. 

• Annual wage amounts have been entered in employee profile. 

• Annual housing allowance declaration has been approved in December of the prior year 

• Any Authorized Federal Withholding amount has been documented on a W4 form for the 
current year.   

• The OCA Pension Fund mandatory employee withholding is subject to federal income tax 
and is included with wages.  The mandatory employer contribution is not subject to federal 
income taxes.  Any additional amounts to be withheld from pay have been entered in 
employee profile. 

• Clergy wages are not subject to Social Security or Medicare withholding.   

• The value of housing for non-clergy living on the premises of the Diocesan office is not 
subject to income or Social Security taxes.  “The tax code allows employers to exclude the 
value of lodging furnished to an employee from the employee's wages if it meets the 
following three tests: (1) it is furnished on the employer's premises; (2) it is furnished for 
the convenience of the employer; and (3) the employee must accept it as a condition of 
employment.”  Richard R Hammar. 

• The Diocese does not contribute to the clergy Self Employment taxes.   

• Paychecks will be direct deposited. 

• The account used for Direct Deposit withdrawals is Wells Fargo Checking 
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Procedure:   

 
1. Open QuickBooks. 
2. Select Employees>Pay Employees>Scheduled payroll.   
 
For each payroll schedule displayed,  

 
3.  In the Pay Employees tab select a Payroll Schedule. 
4. Click on Start Scheduled Payroll.  
5. For salary and hourly checks, the “Check Date” field should be set to the first day of 

the next month or the last business day of the current month for pay period ending the last 
day of the current month.   

6. Confirm that pay period ending date is the last day of current month.  Select all 
employees to be paid. Confirm bank account for payment is Checking at Wells Fargo.  
Select Continue. Go to Step 9. 

 
7. For stipend checks, set the “Check Date” field to the first business day of the next 

month for the pay period ending the last day of next month.  
8. Check the names of those employees to be paid, confirm bank account for payment, and 

click Continue. 
9. Confirm there is a check in the Direct Deposit Column for direct deposit employees. 
10. Click on the “Create Paychecks” button. 
11. Select “Send to Intuit” for processing and for Integration with “View My Paycheck”. 
12. Under the “Items to Send” window, click on Send All. 
13. Refer to the attachment to this manual.  Enter the direct deposit PIN and click OK. 
14. Click OK on the message “Your payroll information was sent successfully.” 
15. When the payroll confirmation report appears in the Items Received window, highlight & 

view it.  Print and file in the next month’s folder. 
16. Select Close. Close the Send/Receive Data window. 
17. Go to step 3, else continue. 

 
18. Click on Close and close the payroll center screen 
 
End of Procedure 
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 Payroll item setup notes for OCA Pension contributions 
 

• QuickBooks cannot compute the pension percentage on a housing allowance.   Every 
year, the payroll item for Mandatory and Deferred Pension on housing must be updated 
to the exact amount to be withheld or deferred.   

• Pension payroll item amounts must be reviewed/changed prior to the first paycheck for 
January. 

• Employee mandatory contributions in QuickBooks are treated like contributions to a 
Roth 401K. 

• Amount withheld from salary is included with the salary in box 1 of the W2 form.  The 
amount withheld from a housing allowance and the housing allowance itself, is not to be 
included in box 1 of the W2 form. 

• The withholding amount for the pension plan is not taxable for Social Security purposes. 
• Amount of deferred contribution (mandatory for company) is not taxable in the current 

year and will not appear in Box 1 of Form W2.  The amount may be included in Box 14 
preceded by the code AA.  Box 13 would be checked. 

 View Paychecks 
 
• Employees may sign up on the website https://paychecks.intuit.com to view their 

paystubs on line.  They will need a copy of their last paycheck. 
 
• Treasurer access to “View my paychecks” through QuickBooks requires the username 

treasurer@dowoca.org and the QB login password. 
 

 
  

https://paychecks.intuit.com/
mailto:treasurer@dowoca.org
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14.3 Pay Payroll Liabilities 
 
Purpose 
 
To pay to the IRS withheld federal income tax, Social Security, Medicare, State income tax, and 
pension contributions.  Note Policies 8.5.1.1 and 8.5.1.2. 
 
Assumptions  

• Paychecks for the current month have been created and sent to Intuit.   

• An OCA Pension Form has been received (emailed from Pension Office) for the payments 
due on the 20th of next month.  It has been saved in Diocesan Files/Employee 
Matters/Pension Forms. 

• Electronic payment of Federal 941 taxes has been set up in QuickBooks. 

• Account and password information appears in an attachment to these procedures 

• Recurring Liability payments have been set up. 

• The Diocese is not subject to paying the Federal Unemployment Tax  

  “Religious, educational, scientific, charitable, and other organizations described in 
section501(c)(3) and exempt from tax under section 501(a) are not subject to FUTA tax 
and do not have to file Form 940.” (from instructions for Form 940) 

• As a nonprofit organization in California, according to the California Unemployment 
Insurance Code (CUIC Section 634.5 (a)), the diocese and all employees (minister and non-
minister) of the diocese are NOT subject to the California unemployment, training, or SDI 
taxes. 

 Pay Federal 941 Taxes 
 
1. Select Employees>Payroll Taxes and Liabilities>Pay Scheduled Liabilities. 
2. Under Pay Scheduled Liabilities, select Federal 941/944 for the period of the current month.  

If no liabilities appear, then pay with the filing of the Form 941 for the quarter. 
3. Click on View/Pay and confirm that the class on the check is “Operating-Operations”. 
4. Note the amount on the check for Federal Withholding, Social Security, and Medicare. 

(latter two will only have an entry if there are non-clergy employees) 
Payment through QuickBooks (current method): 
 
5. Click on E-pay. 
6. Print the confirmation to the printer and save a pdf file under Payroll Liability 

Deposits/20XX Payroll/Federal as yyyy_mm_dd_Tax Payment. 
7. File confirmation form in this month's file folder of checks and receipts.  
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 Pay OCA Pension Liabilities 
 
1. Print Payroll Summary Report for the previous month. 
2. For each employee, fill out the amounts owed on the emailed pension form. 
3. Save the completed pension form and print two copies.   
4. Select ALL scheduled pension liability items for the period of the prior month. (eg. 

Withholding from July paychecks will be paid to Syosset by August 20.) 
5. Select View/Pay 
6. For each QuickBooks Employee 

a. Confirm that the Class on the check is "Administration" and enter the pension code 
from the pension form.  For example, PET10384. 

b. Confirm that the amount calculated on the pension form is equal to the amount on the 
check. 

c. If this is not the last check, click Save and Next and repeat from step a. 
7. Click on Close and Save. 
8. Select File>Print Forms>Checks and print and sign the check(s). 
9. Close the payment summary window and the Payroll Center window 
10. If a non-employee person contributes to the pension plan, go to 12.3.2.1 
11. Attach one printed copy of the form to the associated check stub.   
12. Mail the other copies of the forms with the checks to the OCA. 

 

 Pay California Withholding Tax  
 
1. Select state liability items for the period of the current month. 
2. Select View/Pay. 
3. Confirm that the Payroll item is labeled with class:  Operating-Operations 
To pay through QuickBooks: 
4. Make sure the numbers are right, then click on E-pay. 
5. Print the pdf of the confirmation to Payroll Liability Deposits/20XX 

Payroll/State/California. 
6. File a paper copy in the monthly expense folder. 
7. Enter E-Pay for the check number. 
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 Pay Oregon Withholding Liabilities 
 

1. From the Pay Liabilities window, select the liability payment for OR Withholding and OR 
UI, Transit & WBF. 

2. Select View Pay. 
3. Enter Class:  Administration for all non-zero lines. 
4. Log onto the website, https://OregonEFT.net 
5. See Attachment to Policy and Procedures Manual for log on information. 
6. Select “Make Payment”. 
7. If this is withholding from the last check to be issued in the quarter, enter the State 

Unemployment Tax the company owes for the quarter.  Also enter the amount of the 
Workers Benefit Fund the company owes for the quarter. 

8. If this is not the last check in the quarter, enter withholding information for the month  
9. Submit the payment and print the receipt. 
10. File under Payroll Liability Deposits/20XX Payroll/State/Oregon in the format 

YYYY_QTRX_payment, if this is an end of quarter payment.  If a monthly payment, file it 
as YYYY_mm_dd_WH Payment 

11. File confirmation form in this month's file folder of checks and receipts.  
 
End of Procedure 
 

https://oregoneft.net/
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14.4 Generate Invoices and Statements 
 

Purpose 
 
To assure that receivables are kept to a minimum 

 
Assumptions 
 

• Parishes will be billed for Background Checks performed by the diocese for non-clergy. 

• Customers will be billed for orders of “Saints of America” 

• Occasionally, parishes will reimburse the diocese for a Hierarch’s travel. 

• Occasionally, a member of the Diocesan Council will be invoiced for charges on their 
diocesan credit card if they were made in error. 

• The “Send Forms” preferences for specific invoices and statements should contain the 
desired message that will accompany the emailed invoice and the that preference should be 
set to be the Default for the particular type of invoices to be emailed. 
 

Procedure:  Generate and Email Invoices 
 

1. Create the invoice or statement for a parish using the template appropriate for the item being 
invoiced.  “Email later” should be selected in the header in each invoice. 

2. From the QuickBooks Toolbar, select Send Forms and confirm the format of the greeting is 
correct. 

3. Make sure only the invoices or statements just created are checked. 
4. Click “Send Now”.  Click OK. 

 
End Procedure Generate and Email Invoices 
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Procedure:  Create and Email Statements 
 
1. Select Customers/Create Statements from the QB tool bar. 
2. Select an appropriate statement Template.  Set the statement date for today’s date. 
3. Select the Statement period from the beginning of the current year to today’s date. 
4. Click on the radio button for the preferred send method.  Select email. 
5. Select A/R Account field to Other Parish Receivables or another appropriate Template. 
6. Enter “per Job” in the Create One Statement field. Click on “Print due date on transactions”. 
7. Select “Do not create statements with zero balance” and “for inactive customers”. 
8. Select Preview in order to confirm specified settings were selected.   
9. Click on Email.  Click on Send Now. 

 
End Procedure Create and Email Statements 
 
  



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 87 of 124 

 

14.5 Download Credit Card Charges into QuickBooks.   
Purpose 
To download the charges from the Credit Card Web site and ensure that the entries are complete.  
Assumptions 

• Current authorized holders of Diocesan Credit Cards 
Archbishop Benjamin 
Archpriest Matthew Tate 
Archpriest Ian MacKinnon 
Mary Caetta 
Andrew Smith 
 

• Credit Card statement ending date is always the 9th of the month. 
 
Procedure 
1. In QuickBooks, open the Bank Feeds window and take exclusive access to this function. 
2. On the left side of the window, highlight Chase Web Download. 
3. In the upper right corner of the window, click on the double arrow to begin the download 

process. 
4. The chase login screen will appear.  Log onto the website and under Account 

Summary/Business Accounts, click on “Credit Cards”. 
5. Under All Accounts and across from Current Balance, click on “See activity”. 
6. At the bottom of the window, under Posted Activity, select “Statement ending month 

09,20XX.”, if reconciling the credit card, or “Since last statement”, if doing an interim 
download. 

7. Click on the Transaction Date heading which will sort the column by the oldest date first. 
8. Click on Download and select QB Web Connect QBO file. 
9. Open the downloaded file and select Import Now. 
10. Log out of the website and return to QuickBooks 
11. In the Bank Feeds window, click on the Transaction List button. 
12. The list of all transactions ready to import will appear. 
13. Transactions which QuickBooks recognizes as re-occurring, will be prefixed with the word 

“auto” and will be checked.  The accounts used with these transactions in the past will be 
assigned. 

14. At the bottom of the window, click on Batch/Approve to import the auto transactions. 
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15. For all remaining transactions which are marked as Cha, review the account QuickBooks 
assigned.  They may not always be correct.  Assign an appropriate Account and Class for the 
transaction.  These will be reviewed when receipts are available and verified at a later time.   

16. Do not enter a vendor name for the transaction in this window!  You will lose everything you 
enter when QB “absorbs” the added vendor names. 

17. Click on Batch/Approve to import those transactions. 
18. For the remaining transactions, make a best guess as to the account and class.  You can 

always assign a dummy account Miscellaneous and Class Operating-Operations, if it is not 
obvious how to classify the transaction. 

19. Click on Batch/Approve. 
 
 

End Procedure 
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14.6 Reconcile Credit Card Charges and Pay Credit Card  
 
Purpose 
 
To confirm that all card charges have been captured in QuickBooks 
 
Procedure  
 
1. Go to the Credit Card website and print the single statement covering all cardholders to a 

PDF file.  Save the PDF statement to the Diocesan Files folder in the DOW Bills and 
Receipts folder. 

2. Print the activities, ordered by latest date first, for each card holder to the printer and to a 
PDF file.  Email the cardholder their statements, requesting they verify the charges and 
forward outstanding receipts.  

3. Download credit card activity through the statement ending date into QuickBooks and do an 
initial classification of each charge. Reconcile the charges recorded in the QuickBooks Credit 
Card account, with the charges indicated on the statement.   

4. Allow QuickBooks to generate a manual check for the amount due.  Do not print the check. 
5. Go to the Credit Card Web site and schedule the payment.  Payment date should be the due 

date. 
6. Print the confirmation of the scheduled payment   to paper and PDF 
7. Store the PDF of confirmation with the PDF of the statement. 
8. Attach the paper copy of the payment confirmation to the paper copy of the statement. 
9. Update the manual check generated by QuickBooks to reflect the scheduled payment date.   
10. Enter “website” in the check number field. 
11. Open the credit card register and add vendor names for transactions missing a vendor name 

and make sure each transaction indicates the vendor as shown on the statement.   Use generic 
vendor names rather than vendor/location/codes that you may see.   

 
End of Procedure 
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14.7 Procedure Matching Receipts with Credit Card Charges 
 
Purpose 
To ensure that expenses, charged to the Diocesan Credit Card account, have been properly 
substantiated with a receipt and all QuickBooks transactions have been assigned to the correct 
expense account and the correct QB Class assigned. 
 
Assumptions 

• All charges for the statement period have been downloaded into QuickBooks. 
• Every effort has been made by the holders of the cards to keep receipts for charges.   
• Cardholders have forwarded receipts attached to their individual statements. The 

statement for the cardholder indicates the purpose of the trip and/or the travel expense 
line item to be charged. 

• Receipts must be presented for all expenses over $25.00.   
  
Procedure 

 
1. On each individual printed statement, write an identifying number which indicates the 

date the credit card statement will be paid and the initials of the authorized user. For 
example:  160803MC for payment on August 3, 2016 and authorized user initials MC. 

2. For each employee, verify that the correct receipts have been attached to the statement.     
3. Next to each charge on the individual printed statement, write a sequential number 

beginning with the oldest charge, i.e. #1, #2, etc. for each charge having a matching 
receipt.  Write that number on the associated receipt. 

4. When all receipts received have been associated with a charge, staple the receipts in order 
(#1, #2, etc.) to the printed individual statement, if not previously done.   Charges with no 
receipt should be noted with NR.  

5. In the QuickBooks credit card register, enter the following in the Ref# field for each 
charge:  For example, 160803MC-1 is entered for the charge associated with receipt #1 
on MC’s individual statement.   Confirm the vendor name has been filled in, and that the 
account selected represents the purpose of the charge.   In the notes field enter the 
purpose of the charge indicated by the cardholder on their statement.  Confirm the correct 
class is selected.  Do this for each charge with a receipt. 

6. When all individual statements have been processed, use a binder clip to clip the credit 
card payment receipt, the full statement and reconciliation, and the individual statements 
with receipts together.  Place in the folder for the month in which the credit card payment 
is due. 

7. Before the end of the month in which the credit card payment was due, make sure all 
outstanding receipts have been received and filed.    

8. Re-File the package and submitted receipts in the folder for the month the statement was 
due. 

End of Procedure 
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14.8  Reconciling the Infinity Financial Account 
 
Purpose 
 
To enter monthly balances from the statement into the QuickBooks accounts.   
 
Procedure 
 
Note:  All interest and dividends are credited to Pt Reyes Fund Income: Investment interest 
and dividends.  Class assigned for all transactions is Restricted: Pt Reyes Fund. 
 
1. Print out the monthly statement from the Infinity Web site. 
2. Adjust the value of the securities. 

• Using the “change in value of priced securities” from the right side of page 3 of 
the statement, create a journal entry for the accounts Securities Market Value and 
Infinity Unreal. Gains/Losses. 

3. Enter the total of interest and dividends from page 3 in the Infinity Cash Account. 
4. Adjust the Cash and RBC Insured Deposit accounts. 

a. Find the current value of the RBC Insured Deposit Account from the left side of 
page 3 of the statement.   

b. Create a journal entry for the accounts Cash and RBC Insured Deposit accounts.   
5. The value of Cash at the end of the month is usually zero dollars but confirm by checking 

page 4 of the statement.  If there is any value for Cash, it will show after the Total RBC 
Insured Deposits line. 

6. Proceed to reconcile the top-level Infinity Financial – R account with the statement Current 
Account Value on the left side of page 3. 

7. Print out the detailed reconciliation to a PDF on the Gdrive and to the printer. 
8. Staple the reconciliation to the back of the Infinity statement. 
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14.9 Prepare the Monthly Folder  
 
Purpose 
 
After the end of the month, reconcile the statements from financial institutions with the account 
information in QuickBooks.  File the statements, reconciliations, checks and receipts in the 
monthly folder. 
 
Policy  
 
The Treasurer shall perform the reconciliation of the financial institution statements with the 
associated QuickBooks Asset Accounts.    
 
Paper or electronic statements from banks and financial institutions shall be made available to a 
member of the Finance Committee.  That person shall review the checks that have cleared the 
account, deposits that have been made, and investigate any unusual transactions.   
 
Physical checks and electronic payments shall have substantiation attached to them. 
 
Procedure 
 
1. Reconcile all asset accounts and organize the left side of the monthly folder for the report 

month as indicated below. 
 

    Organization of asset documents in Monthly folder: 
 

Clipped on the left side of the folder are: 
 

- Statements and Reconciliations for asset accounts 
- Deposits to the asset accounts 
- Electronic transfers between the asset accounts 
- Other relevant communications regarding the asset accounts. 

 
2. Print transaction list from checking account to a comma delimited file.  Open the file in 

Excel and delete the account, memo, reconciliation and memo columns.   
3. Sort all transactions by check number.   
4. Sort all electronic transaction by date.  Highlight and cut rows of the latter to the top of 

sorted check list. 
5. Delete all rows that are associated with deposits and/or journal entries.  Save file as 

mm_sorted and print the list. 
6. Using list, file the checks and matching substantiation on right side of the folder in the same 

order as list. 
       Organization of payment documents in Monthly folder: 
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- List of checks/payments from WF account in check number order, i.e. electronic 
transactions, then online transactions, then physical checks1 

- Copies of electronic payments in order by date of payment, and associated invoices. 
- Copies of QB online transaction reports and associated receipts, in order by number. 
- Physical check vouchers and associated receipts in voucher number order from low to 

high 
  

7. Update the credit card account with transactions through the end of the report month. 
8. Run the QuickBooks report Company & Financial/Profit & Loss by Class, year-to-date, 

collapsed. 
9. Review the line items by class to make sure activities have been properly classified and that 

no transactions have been marked as unclassified. 
10. Correct any classification errors. 

 
End of Procedure  

                                                 
1 At the top of the check register, select Print and print to a comma delimited file.  Open 
the file in Excel, sort by check number and then by date.  Remove unnecessary deposit 
lines.    
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14.10 Prepare Monthly Financial Report 
 
Purpose 
 
Generate and distribute a monthly financial report package to the members of the Diocesan 
Council, Diocesan Departments, Deans, Finance Committee, and Audit Committee. Generating 
and reviewing these reports assists the Treasurer in finding errors. 

 
Assumptions 

• The Treasurer’s Web page has been formatted to accept links to monthly financial reports. 

• All reports will be accrual based reports. 

• Sections 13.6 through 13.10 have been executed through the end of the month to be reported. 

• The monthly paper folder has been organized and all Quick Entries have been properly 
classified. 

• The report package will consist of the following at a minimum: 

° A verbal summary of the month's financial activities  
° A consolidated balance sheet showing roll-up and detail of financial position of 

operational and restricted funds as of the end of the month.  
° An Operating P&L for the year to the report date, showing roll-up detail and comparing 

actuals with what was budgeted for the entire year. 
° Balance Sheets & P&Ls for restricted funds for Finance/Budget Committee. 
° Detailed Operating P&L and Detailed Consolidated Balance Sheet for the 

Finance/Budget Committee. 
 
Main Procedure: Generate and Distribute the Monthly Report 
 
1. Open QuickBooks 
2.  Select Reports/Process Multiple Reports. 
3.  From the drop-down box, select the memorized reports from Monthly Treasurer Report.  

The following list will appear. 

• MR00 - Profit & Loss by Class  

• MR01 – Consolidated Balance Sheet 

• MR02 – Operating Funds Balance Sheet 

• MR03 - Operating Profit and Loss Budget vs. Actual 

• MR04 - Pt Reyes Funds Extracted Balance Sheet 

• MR05 - Pt Reyes Fund Profit & Loss Budget vs Actual" 

• MR06 – Mission Funds Extracted Balance Sheet 

• MR07 – Mission Funds Profit & Loss  
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• MR08 – Scholarship Funds Extracted Balance Sheet 

• MR09 – Scholarship Funds Profit & Loss 

• MR10 – Other Restricted Funds Balance Sheet 

• MR11 – Other Restricted Funds Profit & Loss 

• MR12 - Open Invoices  
4.  Edit the “to” date to be the end of the prior month, with the exception of “Profit & Loss vs 

Actual” reports.  The “to” date on the latter should be 12/31/XX  so that an annual YTD 
budget figure will be displayed on the report.  The “from” date for balance sheet reports must 
be January 1st of the current year so that the report will print out the prior year ending 
balances on the report. 

5. Select Display button. 
6. Open and review the report, MR00 - Profit & Loss by Class. 

a. Look in column Total Operating. 
b. Confirm there is zero dollars in the Restricted Income and Restricted Expenses 

rows.  If there is a number in one or both of those rows, correct the class of the 
contributing transactions. 

c. Confirm there is no column Operating-Other.  If that column exists, then correct 
the class of the contributing transactions from Operating to Operations-General. 

d. The column Unclassified should all be zero is Step 3 was performed. 
 

7. Review each of the MR01-MR03 reports in expanded form and correct any bookkeeping 
errors revealed.   

8. Print the expanded form of MR01 and MR03 and a collapsed form of MR02 to a PDF and to 
the printer and save the files in the directory Diocesan Documents\Treasurer Reports\20XX.  

9. Export a collapsed version of QuickBooks Consolidated Balance Sheet Report, MR01, to a 
new Excel spreadsheet (….20XX\yyyy_mm_dd_Balance Sheet Summary) and format to a 
one-page report, using the previous month Excel spreadsheet as a guide. Using the report, 
“Company & Financial/Profit & Loss by Class”, add the contributions to net income of the 
restricted funds after the last line of the balance sheet information.  The net income should 
equal the sum of the contributions from each class. Adjust report to 95% and center on the 
page horizontally.  Adjust margins, if necessary.  Print to a PDF in the directory Diocesan 
Documents\Treasurer Reports\20XX as yyyy_mm_dd_ Cons Balance Sheet Summary. Print 
to printer. 

10. Export the expanded MR03 Operating P&L report to an Excel spreadsheet 
(…20XX\yyyy_mm_dd_P&L Summary) and format the spreadsheet to a one-page report 
collapsing to the major categories.  Adjust to 95% and adjust all margins to fit report on one 
page, and then print to a PDF in the directory Diocesan Documents\Treasurer Reports\20XX 
as yyyy_mm_dd_ P&L Summary. Print to the printer. 

 
11. Print the rest of the reports to a pdf and to the printer. Hardcopies fare for the Treasurer’s 

paper records. 
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12. Open the Word version of Diocesan Documents\Treasurer Reports\20XX 
Reports\mm_<Previous Month> Cover.  Refer to the above printed reports to fill in the 
necessary detail to create this summary report. 

13. Save this summary report as <Current Month> Cover.  Print the summary report cover to the 
printer and then to a PDF file named <yyyy_mm_dd_ > Financial Report Summary.  Append 
the pages from the PDF of the Balance Sheet Summary Report and P&L Summary Report 
and save this report in the 20XX directory.  

14. Create one PDF report from the detailed Balance Sheet, Unrestricted P&L Actual vs Budget, 
and restricted funds reports and save the resulting report as <yyyy_mm_dd_ Financial 
Report-Detailed. 

15. Close QuickBooks 
16. Email the <yyyy_mm_dd_> Financial Report Summary and the <yyyy_mm_dd_ Financial 

Report-Detailed as attachments to the distribution list indicated in the purpose of this 
procedure and to the Administrative Assistant.  The distribution list is maintained in the 
Outlook group Monthly Financial Report. 

17. Email the checking account bank statements to the appropriate member of the Finance 
Committee. 

 
End of Procedure 
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15 QUARTERLY TASKS 

15.1 Create a Quarterly IRS Form 941 
 
Purpose 
 
Create and file Form 941 with the IRS to reconcile monthly withholding tax deposits. 

 
Assumptions 

• The IRS had the correct legal address and information when Web was used initially to enter 
the monthly deposit information. (Obsolete) 

• The individual submitting form 941 through QB has been issued a Form 94X on-line 
signature PIN. 

• If no PIN assigned, then the paper form must be mailed to the IRS. 
• All payroll in the quarter has been processed. 
 
Procedure (To be Revised) 
 
1. Open QuickBooks 
2. Select Reports/Employees & Payroll/Payroll Summary (unclick rate and hours box). 
3. Select this or last calendar quarter for the date range. 
4. Click OK. 
5. Print the report to the printer and to a PDF file and save to Payroll Liability Deposits\yyyy 

Payroll\QtrN Payroll Summary. 
6. Select Employees>Payroll Tax Forms & W-2s>Process Payroll Forms. 
7. Under the file forms tab, select “Quarterly Form 941/Schedule B”.  Click on Create Form, 

then enter the appropriate quarter, and then click OK. 
8. Proceed through the steps displayed by QuickBooks.  It is not necessary to complete a 

Schedule B. Enter CA for the state where deposits are made. 
9. For line 1, enter the number of clergy and lay employees who received any compensation, 

even if only housing, in the reported quarter.   
10. Compare the deposit amounts for the quarter with the QuickBooks deposit amounts.   
11. Line 2 of Form 941 should be the sum of the total Gross Pay of those receiving wages and 

salaries. 
12. Print the Form 941 to Acrobat and save in Diocesan Files\Payroll Taxes\yyyy 

Payroll\Federal\941qtrN.   
13 Select E-file and enter your 10-digit PIN. 
 
End Procedure 

  



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 98 of 124 

15.2 Prepare Quarterly, California (EDD), Wage and Withholding Report, 
Form DE 9 and DE 9C. 

 
Purpose 
For employees who work in the State of California, to report to the State, the amount of 
withholding from employees' checks during the previous quarter  

 
Assumptions 

• EDD Employer Account number is 816-6101-9 
• California Income Tax withheld from employees' check during the quarter has been paid 

electronically (See 12.3.3) 
 

Procedure 
1. Unless already created for Form 941 submission, generate a quarterly wage report by 

selecting Reports\Employees & Payroll\Payroll Summary (unclick rate and hours box). 
2. Select this or last calendar quarter for the date range. 
3. Click OK. 
4. Print the report to paper and a PDF file.  Save the PDF under the Payroll Taxes directory.  

Save with a filename “QtrN Payroll Summary”.  Close the report screen. 
5. In QuickBooks, select Process Payroll Forms 
6. Select DE9 for previous quarter. 
7. Select OK, print to PDF as Qtr X DE 9, and to the printer. 
8. Select e-file. Click on submit and print confirmation to PDF and printer. 
9. Under file forms tab, select DE9C for the previous quarter. 
10. Enter P for the Wage Plan Code. 
11. Enter the number of CA withholding employees. 
12. Enter the date to be submitted. 
13. Select Submit Form. 
14. Print to PDF as Qtr X DE 9C, and to the printer. 
15.  Select e-file, select Submit.  Print confirmation to printer 
16. Make sure the copies of Forms DE 9 and DE 9C are saved in the Payroll taxes paper file and 

electronically under Diocesan Files\Payroll Taxes\YYYY Payroll\California. 
17. After 24 hours, confirm that the request was accepted. 
 
End of Procedure 
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15.3 Prepare Quarterly Oregon Payroll Tax Report 
 
1. In QuickBooks, select payroll form, OR Quarterly Tax Report and review the information 

generated, adding anything missing. 
2. Save the PDF under QTRX 20XX and print to printer. 
 
3. Log onto http://www.oregon.gov/EMPLOY/Businesses/Tax/Pages/SETRON.aspx. 

 
4. Click on Begin SETRON at bottom of screen 

 
5. Fill in form, selecting YES for filing form 132 and using the QuickBooks information from 

step 1. No dash in EIN. 
 

6. Click Continue 
 

7. On Form 132, fill in line for Oregon non-clergy employee. 
 

8. Enter 0.00 for unemployment withheld. 
 

9. Enter unemployment tax rate of .0090 (2018) 
 

10. Enter the hours worked in the quarter (use 20 hours/month) 
 

11. Enter amount of State Income Tax withheld. 
 

12. Click Calculate and review the information.  Click Continue. Click Submit. 
 

13. Print to PDF as QTRX 20XX SETRON FORM under Payroll liabilities/Oregon.  
 

14. Print to printer and file in Payroll folder with other quarterly reports. 
 

15. Pay any amount due per Section 13.3.4. 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 100 of 124 

15.4 Adding/Removing a Stipend Payee 
 
Purpose 
 
To record and report necessary information when there is a new addition to the list of those 
receiving stipends not designated as a housing allowance.   

 
Assumption 

• Those receiving stipends are paid as independent contractors and will receive a 1099 form.   

• The check dated the first of the month covers work performed during that month. 

• The Dean of the Missions Deanery has submitted to the Diocesan Council a revised list of 
mission priests who should receive stipends. 

 
Procedure (Add a Mission Stipend Payee as a QB Vendor) 
 
1. Open QuickBooks and display the list of vendors. 
2. Click on Vendor>New 
3. Enter the information about the mission priest on the Address Info tab. 
4. Click on the Additional Info tab 
5. Enter Last name into Account Number field 
6. Enter Non-Employee into the Type field 
7. Enter the priest’s Social Security Number in the Tax ID field. 
8. Check the box Vendor eligible for 1099 
9. Click OK 
End Procedure 
 
Alternate Flow at Step 1 (Vendor already in QuickBooks) 

 
10. Double-Click on the name of the mission priest. 
11. Click on the Additional Info tab 
12. Continue with Step 7 
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Procedure (Update Existing Memorized Stipend Transaction) 
 
1. Select Lists>Memorized Transactions List 
2. Scroll down to Stipends – Missions  
3. Double-Click on name of mission priest in the list. 
4. In the check window that opens, update the amount of the stipend to be paid in succeeding 

months. 
5. Select Edit>Memorize Check 
6. Click on Replace 
7. Close window and Click on No. 
End Procedure 
 
Procedure (Create a Memorized Stipend Transaction) 

 
1. Click on the Write Checks Icon at the top of the QuickBooks Menu 
2. Create a check for the mission priest entering the amount of the monthly stipend 
3. Select Edit>Memorize Check 
4. Enter the Mission Priest Name in the Name field 
5. Click on With Transaction in Group 
6. Enter Stipends – Missions in the Group Name field 
7. Click OK 
End Procedure 
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16 ANNUALLY 

16.1 Determine the Parish Percentage for Next Year 
The Parish Percentage Assessment is an assessment paid by the diocesan parishes for the support 
of the diocesan and Orthodox Church in America operating budget.  The percentage of parish 
eligible income to be paid in a given year is determined according to the policy in Section 9.6 of 
this manual.   
1. In December prior to the new year, determine each parish’s percentage based on the policy. 
2. Create a monthly computation form for each percentage for the coming year and email it to 

the respective parish treasurers. 
 
 

16.2 Request Parish Send Annual Financial Report and Annual 
Reconciliation Sheet via Email. (December)  

 
Purpose 
 
To remind parishes that the Annual Reconciliation Sheet will be used to reconcile what a parish 
actually paid during the year versus the assigned parish’s percentage of the year’s eligible 
income. 
 

 
Assumptions 

• Today’s date is about December 15. 
 
Procedure:  
 
1. Modify the annual letter to parishes, which is located in c:\Diocesan Files\Templates\ 

Request for Annual Report Info_YYYY.doc.  Create a pdf of the letter. 
2. Modify and generate an annual recap form for each percentage category.  Append to the pdf 

of the letter. 
3. Email this letter and reconciliation form to each parish. 
 
End Procedure 
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16.3 Prepare Payroll for Coming Year 
 
Purpose 
 
Ensure consistency between approved budget compensation and QuickBooks payroll function.  
To set up payroll items to reflect necessary payroll items.  To create payroll schedules which 
are used to generate paychecks in a timely manner.   
 
Assumptions 
 
The budget for the next year has been approved. 
 
Procedure 
 
Generate Housing Allowance Determination forms and distribute to clergy receiving salary 
and/or stipends. 
 
Prepare the formal determination forms and present them at the December Diocesan Council 
Meeting for acceptance and signature by the Secretary of the Diocesan Council. 
 
Send out W4 forms to clergy employee who may want to have Federal Income Tax withheld 
from their paychecks. 
 
Create new payroll items that may be needed to track to expense line items. Set up/update 
pension amounts for each clergy employee. 
 
Assign employee payroll to an appropriate schedule.  Stipend (pay for current month), or salary 
(pay for prior month), based on approved budget line items.   
 
Set up/update payroll information for each employee using the amounts from the budget. 
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16.4 Perform Reconciliation of Prior Year Parish Remittances Paid versus 
Owed. 

 
Purpose:  
 
To receive and track receipt of prior year parish financial reports and reconciliation forms.  To confirm 
past due remittance payments are made and credit or refund overpayments. 
 
Assumptions:   
A parish annual financial report and Annual Remittance Reconciliation Form has been received 
from a parish. 
 
Procedure: 
1. Store financial reports and remittance reconciliation forms on the Gdrive under Parish 

Finances & Membership\20XX_Parish Reports_Recons. 
2. Enter the information from the parish Annual Reconciliation Recap form into the Excel 

spreadsheet, Google Drive\Diocesan Treasurer Files\Parish Financials & Membership\20XX 
Remittance Tally Sheet. 

3. Confirm Gross Income on reconciliation form is the same as that reported in the financial 
report(s). 

4. If there are discrepancies between the reconciliation form and the report, contact the parish 
treasurer and discuss those discrepancies. 

5. If the spreadsheet shows that assessments are owed from the previous year, monitor deposits 
for previous year remittance payments.   

6. If the spreadsheet shows that assessments for the prior year exceeded what was owed, either 
generate a refund check to the parish or apply overpayments to the current year remittances. 

 
End of Procedure  
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16.5 Make year-end transfers for budgeted set-asides from operating 
account.   

 
 
Transfer budgeted funds not spent in the year to set aside asset accounts.  The expense accounts 
which have unspent funds rolled into a corresponding Council Set Aside account in the savings 
account include: 
 
• Professional Fees/CPA - External Audit SetAside 
• Professional Fees/Legal Fees – Legal Fund SetAside 
• Clergy and Parish Resources/Liturgical Supplies – Liturgical Supplies SetAside 
• Outreach Expenses/Intern Program – Internship Fund SetAside 
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16.6 Prepare a Budget Worksheet for the Budget Committee 
 
Purpose 
 
To describe the process of providing a budget worksheet for use of the Budget Committee.  

 
Assumptions 
 
• The head of the Finance/Budget Committee has scheduled a meeting date. 

• The Administrative Assistant has distributed a budget memorandum by July 1 of the current 
year. 

• The head of the Budget Committee leads the presentation of the budget to the Diocesan 
Council and to the Diocesan Assembly 

 
Procedure 
 
1. Generate the monthly report, MR03 - Operating Profit and Loss Budget vs. Actual. 
2. Export the report to the first worksheet (Sheet 1) in an Excel workbook. 
3. Re-run the report with an ending date of July 31st and export to a new worksheet (Sheet 2) in 

the above Excel workbook.  
4. Save to a local computer that has Excel.  
5. Change the title on Sheet 1 to Draft 20XX Operating Budget. 
6. Remove the date range and other irrelevant title information from the top of the worksheet. 
7. Go to Sheet 2 and copy the actuals through July column and paste (F) over first column of 

figures in Sheet 1. 
8. Delete Sheet 2. 
9. Change the column headers to: 
 

Thru July 
31, 20XX  

Current 
Year 

Budget  

% of 
Current 
Budget  

Proposed 
20XX 

Budget  Comments 
 
10. Add narrow columns on either side of the last two columns. 
 
11. Copy the current year budget column numbers and paste (F) over the proposed budget 

column rows. 
12. Enter zeros in all non-formula cells of the Proposed 20XX column. 
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13. In the worksheet column A, add line numbers. (Use Fill/Series) 
14.  Set sheet print orientation to landscape.  Select and set the print area.  
15. Set gridlines to print. 
16. Select Print to Adobe PDF and adjust columns to fit columns to one-page wide.  
17. Print to Gdrive under Budget Preparation as 20XX budget. 
18. Save Excel workbook under Budget Preparation as 20XX budget. 
19. Email the PDF and Excel versions of the draft budget to head of budget committee for 

processing and finalization. 
20. Be available by phone when the Finance/Budget Committee meets. 
21.  Obtain an electronic copy of the Excel spreadsheet to be presented to the DC. 

 
End Procedure 
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MEMORANDUM 
 

Date: July 1, 20XX 
 
To: The Diocesan Council, Diocesan Charitable and Monastic Institutions, and Department Chairs 
Re: Submitting Budget Requests 
 
This memorandum describes the process used to create the Proposed Budget submitted to the Diocesan Assembly 
for its approval.   It is distributed to inform and facilitate budget requests. 
 
1. The Diocesan Council has appointed a Finance/Budget Committee.  Current members are:  (insert names of 

members of Budget Committee)  
 
2. The Diocesan Treasurer shall elicit budget requests for 2004 by distributing this memorandum by July 1, 

20XX. 
 
3. All budget requests must contain the name of the requesting party, the proposed project, the amount requested 

and other sources of funds, if any.  Proposed purchases should be supported by vendor quotes or other price 
research.  The request should indicate how much will be spent on what and approximately when the expenditure 
will occur. 

 
4. Budget requests from Diocesan Institutions shall be sent prior to August 1, 20XX  to:  
 

Charities Department, Diocese of the West 
(Insert address of Chairperson) 

 
5. The Diocesan Charities Department shall review the projects proposed by the institutions and the amount of 

financial assistance requested, consider and prioritize those requests and submit that prioritized list of their 
recommendations and original requests to the Finance/Budget Committee by August 15, 200X. 

 
6. All other budget requests shall be sent to the Office of the Finance/Budget Committee by August 15. 
 
7. The Diocesan Treasurer shall provide and propose initial funding levels for next year’s budget. 

Finance/Budget Committee shall review year-to-date actual figures for already-funded projects, the budget 
recommendations received and the funding request for new projects.   

 
8. The Finance/Budget Committee shall convene in the third quarter of the year prior to the meeting of the 

Diocesan Council.  The Budget Committee shall review the proposed budget, make those changes it supports 
and finalize the Proposed Budget for presentation to the Diocesan Council. 

 
9. The Diocesan Treasurer shall publish the draft of the Proposed Budget prior to the Diocesan Council’s 3rd 

quarter meeting.  If time pressure requires, this draft may be included in the Delegate Report Book with the 
advisory that the Diocesan Council must still review and approve the Proposed Budget that will be considered 
by the Diocesan Assembly. 

 
10. The Diocesan Council shall then make final changes to the draft budget.  The Diocesan Treasurer shall 

incorporate these changes into the Proposed Budget and prepare it for presentation to the Diocesan Assembly 
by a member of the Finance/Budget Committee. 

 
11. The Diocesan Assembly shall discuss the Proposed Budget, make any changes (by majority vote) and formally 

adopt the budget for the following year.  
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16.7 Create Stewards of the West List for the Delegate Report Book and 
Year End 

 
Procedure 
 
1. Open the memorized report “Stewards of the West 20XX” under the customers report section 

in QuickBooks. (Filtered by Item Filter using Items “Stew 20XX” and “Stew Pledge 20XX”, 
cash basis, sort by total desc.) 

2. Set Date Range from January 1 of report year to December 31 of report year.  Cash Basis 
should be selected to pick up partially paid pledges. 

3. Generate the Report. 
4. Export the data to a new Excel spreadsheet and save to a local computer.  Name the Excel 

file “20XX Interim report”. 
5. Delete the header of the report 
6. Ungroup the row data 
7. Remove the screen split 
8. Count the number of donors and enter that into the template for the report. 
9. Delete rows with blank amounts and/or with the word “Total”. 

• Make sure the name on the row above the “Total” line is correct.  If it is a parish name, 
put the city name after it in parenthesis if there is more than one parish of that name in 
the Diocese of the West. 

• Cut the name in that row and paste it to begin in column B. 
• Remove the borders in the cells in the amount columns. 
• Make all rows “auto fit” height. 

 
10. In one Sort command window with two levels; sort by the Amount column, descending, and 

then Name column, ascending. 
11. Add the words “Total Contributions” at the end of the list in the NAME column and add the 

total contribution amount as text after it in the same column. 
12. Manually insert a blank row to divide the names into the SOW ranges 

• GE $1,000   (Torch Bearers) 
• GE $500, LE 999.99  (Standard Bearers) 
• GE $100, LE 499.99  (Sustaining Member) 
• Remaining range   (Donors) 

 
13. At the top of the spreadsheet, insert the names of any existing Lifetime Beacon donors from 

previous year’s report (i.e. 20XX Stewards of the West_YE”), plus any new Beacon 
members from this report year. 
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14. Enter SOW category above each section in names column in font Times New Roman 16 and 
names as Bold Times New Roman 10. 

15. Tidy up the parish names and remove any {C} from the fields.  Remove any numbers (for 
example 800) and make sure all names are sorted alphabetically within each donor group. 

16. Delete the dollar amount column. 
17. Save the Excel file in Diocesan Treasurer Files/Donation Acknowledgements/SOW 

Acknowledgement Letters as “20XX (Current year) Stewards of the West List” in the 
appropriate year folder. 

18. Open the Word document template in the folder Donation Acknowledgements, “20XX 
Stewards of the West Template”.   

19. Save the file to a new Word document, omitting “_Template”, to the appropriate year folder. 
20. Update the first paragraph information so that it is appropriate for either the Delegate Report 

Book in October or the Year End Report posted on the Web Site.    
21. Copy and Paste (Overwrite Cells) the names from the sections of the Excel spreadsheet into 

the appropriate columns in the Word document.  Delete any extra names that may remain 
from previous versions or add rows as needed.  Center the names within the columns. 

22. For Sustaining Members, you cannot Paste (Overwrite Cells) across a page break.  Instead, 
highlight the rows on a single page before doing a Paste (Overwrite).  Do a second 
Copy/Paste (Overwrite) from the balance of the names in that section of the spreadsheet to 
the columns on the next page of the Word document. 

23. Do the same as in 23) for the Donor members. 
24. Make sure all entries fit in a single row within the column.  If necessary, make the column 

wider. 
25. Create an Adobe PDF file from the Word document by the same name.  Close the Word file.  

Email the PDF file to the Administrative Assistant to either post it to the Diocesan Web Site 
or include it in the Delegate Handbook for the Diocesan Assembly. 

 
End Procedure  
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16.8 Create Treasurer’s report for Delegate Report Book (September 1) 
 
 
Purpose 
 
To create the necessary reports that will be included in electronic Delegate Report Book. 
 
Assumptions 

• The previous year’s audited financial report and auditor’s report shall be posted on the 
Diocesan Web site. 

• The reports to be included in the electronic Delegate Report Book are: 

  Current month (August) operating income and expense year-to-date budget vs actual 
report 

  Current month (August) consolidated balance sheet  

  Previous 5-year census report  
 
Procedure 
 
1. Retrieve the following PDF files: 

a) the current year August Financial Report Summary  
b) the previous year’s audited Financial Report Summary 
c) the audit findings of previous year  

2. Open the file Diocesan Files\Parish Financials & Membership\Historical Census 
Reporting to Assembly\Census_to_01_Sept_XX. 

3. Use the latest figures from this file to update the Delegate Report Book Census Report. 
4. Email the reports to the Administrative Assistant. 

 
 
End Procedure 
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16.9 Prepare and Submit Forms 1099, W2/W3  

 Create and Submit Forms 1099 to IRS (Due January 31st following 
tax year) 

 
Purpose 
 

To create the Federal Form 1099 for each person receiving a non-housing allowance stipend from 
the diocese and file them with the IRS and email the forms to the recipients. 
 

Assumption 
 

• All vendors have an email address stored with their QB vendor information. 
• These vendors also do not participate in the OCA pension plan 
• If vendors receive other 1099 income, then the Diocese may issue them a 1099.  In that 

event, Box 7 should contain BOTH salary and housing allowance amount. 
 
Procedure 
 
1. Log into the DOW data file in single-user mode. 
2. From QuickBooks, select Vendors/Print e-file 1099s. 
3. Run the 1099 Wizard.   
4. Confirm that all qualified vendors appear on the list and confirm non-employee 

compensation amounts are correct. Go through steps until the Choose a Filing Method 
appears. 

5. Preview the forms, confirming that each vendor name, address, and social security 
number is correctly displayed. 

6. Now select Tax1099.com E-file/Upload 1099 Data. 
7. Log into the Tax1099 program with email and password in the Attachment. 
8. Confirm the import shows all vendors on the 1099 Summary Report. 
9. On left side of screen, select all the vendors and don’t unmask the TINs.  
10. Select Send.   
11. Enter payment information, using the diocesan credit card. 
12. Select Pay & Submit to e-file.   
13. Go to the Dashboard in the Tax1099 program to review the submittal. 
 
End Procedure 
 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 113 of 124 

 Create and Submit W2 and W3 Forms to IRS (Due January 31 
following tax year.) 

 
Purpose 
 
To prepare the W2 forms to be mailed to diocesan employees 
To prepare the W3 package for the Social Security Administration 

  
Assumptions 

 
• Ordained clergy should be issued W2s if they claim a part of their diocesan compensation 

as housing allowance and/or they participate in the OCA Pension Plan.     

• Sum of all 941-line 2 reported data agrees with YTD payroll summary W3 Box 1 

• Sufficient W2 laser printer forms have been procured to mail to recipients. 

• A clergy employee, for whom the diocese only pays medical insurance, is not issued a 
Form W2 (per IRS 10/8/2010) 

•  Beginning January 2018, all W2s must be filed electronically.  Oregon W2s must be 
filed electronically both in the federal system and in the State System.)   

 
Procedure 
 
1. Open QuickBooks and select Employees/Payroll Tax Forms & W-2s/Process Payroll 

Forms. 
2. In the File Forms window, scroll down and select Annual Form W2/W3 and click on 

Create Form. 
3. Select all employees and click OK. Click the Statutory box for all clergy.  
4. Select and review each W2.  (For clergy employees, Box 1 amount should equal the 

salary portion of compensation plus any mandatory employee contribution to the OCA 
pension fund.   It should not include any housing allowance.    Employer contribution to 
OCA pension plan for the individual should appear in Box 12.  The housing allowance 
should appear in Box 14. 

5. Verify the Form W3 Summary is correct and agrees with the total reported on Form 941. 
6. Click on E-File Federal Forms. 
7. Enter the submitters phone number and select Submit. (Message will appear saying 

submission will be acknowledged in 4-6 weeks.) 
8. Print confirmation and save as PDF under Federal folder of Payroll Liability Deposits. 
9. On the Print/Efile form, select print.   
10. Select “preprinted form” and click on Copy D for the Employer.  Click on Print PDF. 
11. Place Form W2 Copy D in the printer and print the latter PDF onto the form. 
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12. Then select Copy B, Copy 2, and Copy C as in previous step and print the PDF onto 
those forms. 

13. Place these forms in the accompanying envelope and mail them. 
 
End Procedure  
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 Create and Submit W2 forms to Oregon Department of Revenue 
 
Assumptions 
 

• Form W2 for employees, subject to withholding and living in Oregon have been 
submitted electronically to the IRS 

• The W2 forms for mailing to those recipients have been printed. 
 
Procedure 
 

1. Have employee copies of W2s in front of you. 
2. Go to the Oregon Department of Revenue web site, www.oregon.gov/DOR 
3. Click on Revenue Online.  Click on Revenue Online on next screen. 
4. Enter login credentials as provided in the Attachment. 
5. Click on File W-2s and 1099s using iWire. 
6. Select manual entry. 
7. Fill in the form as follows:   

a. Employer Type: none apply 
b. Employment Code: Regular 941 

8. Click Next. 
9. Click Add/Delete/Edit W-2. 
10. On next screen click on Add W-2. 
11. Copy the information from the paper W-2 onto the electronic form. 
12. Click OK. 
13. Repeat for each additional W-2. 
14. Click OK and then Next. 
15. Fill in the submitter contact information. 
16. Click on Submit and then on OK. 
17. Print the confirmation email received to a pdf and store with other Oregon payroll forms. 
18. Logout. 
End Procedure 

 
 
 
 

http://www.oregon.gov/DOR
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 Prepare Annual Oregon Withholding Tax Reconciliation Report 
 
Assumptions 
 
Forms 1099-Misc and W2 for employees, subject to withholding, living in Oregon have been 
finalized and filed with the IRS. 
 
Procedure 
 
1. Go to Employees/Payroll Tax Forms & W2s/Process Payroll Forms. 
2. Select WR-Annual Withholding Tax Reconciliation Report for Oregon. 
3. Click on Create Form.   
4. Select reporting year. 
5. Print to a PDF and e-sign PDF.  Save in payroll liabilities folder for Oregon.   
6. Mail form to Oregon Department of Revenue by January 31st after the reporting year. 
  



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v9.00 
  

 

Page 117 of 124 

 
 

16.10 Year-End Close (Draft) 
 
1.  Defer revenue of customer payments received in prior year for open invoices in current year.  
 

a. Create a General Journal Entry for each customer 
Debit the receivable account  
Credit the deferred revenue account 
Date Journal entry as last day of prior year. 
 

b. Create a General Journal Entry dated the first day of the next year, receiving the revenue, 
Credit the receivable account 
Debit the deferred revenue account 
Open the Customer's record and the receive payment window.  Date the payment 
1/1/20XX and apply the credit. 

 
2. To determine that income has been deferred, i.e. that payments received in December for 

January invoices have been deferred, run the report A/R Aging Detail and look for negative 
amounts for any payments.  There should not be any positive payments on this report that are 
not balanced with a deferred payment.   
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17 BI-ANNUAL TASKS 

17.1 Filing a Statement of Information (CA Form SI-100) 
Purpose 
 
To inform the State of California about the names and addresses of current officers. 
 
Frequency of Use 
 
This task is performed every two years, online, for each California-based church as well as 
the Diocese of the West. 

 
Procedure:  File Online 

 
1 Go to the website:  https://businessfilings.sos.ca.gov and enter the name The Diocese 

of the West, OCA. 
2 Click on the name when it appears in the Search List.  Click on Continue Filing. 
3 Click NO on the screen dealing with Common Interest Development Association. 
4 Click Continue. 
5 Fill in the form with the names and addresses of the current officers. 
6 Submit the form. 
7 Pay the fee ($20.00 in 2015) with a credit card. 
8 Enter an email address for an emailed copy. 
9 Select Request an email copy. 
 
End Procedure 

 
  

https://businessfilings.sos.ca.gov/
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18 CONFIGURE QUICKBOOKS FOR THE DIOCESE OF THE WEST 

18.1 Set up a Parish as a QuickBooks Customer 
 
Each Parish is set up as a QuickBooks Customer, Customer type DOW Parish, with two jobs 
associated with it. 
 
Job:  Parish Assessment 
Customer Type:  DOW Parish 
 
Job:  Parish Name 
Customer Type:  Donor 
 

18.2 Set up a Donor as a QuickBooks Customer 
 
Each Donor should be set up as a QuickBooks Customer with a Customer Type of Donor. 
 

19 REPORTING NEW EMPLOYEES TO THE STATE OF CALIFORNIA (ANYTIME) 

The State of California must be notified when a new employee is hired. 
 

 
 

Procedure: Report using the internet 
 
1. Log onto http://eddservices.edd.ca.gov/index.html 
2. Click on e-Services for Business Login. 
3. Refer to the attached hardcopy attachment to find the userid and password for the EDDS 

services web site. 
4. Under my accounts, click on account id. 
5. From the list of “I want to”, select “file report of new employee. 
6. The Internet New Employee Registry screen appears. 
7. Select “Create a new DE34” and add new employee information 
8. Click Save and click Submit 
9. Print copy to PDF for CA employee Inf. 
10. Log out. 

 
End Procedure  

http://eddservices.edd.ca.gov/index.html
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20 REPORT INDEPENDENT CONTRACTORS TO THE STATE OF CALIFORNIA 
(ANYTIME) 

Purpose 
To fulfill the requirement of the State of California to report those receiving 1099 Forms as 
contractors as soon as it is expected they will earn over $600.00 for the year. 

 
Assumption 

• All independent contractors must be reported and not just those living in California. 

• Contract date starts in November after the Diocesan Assembly and ends the last day of 
October. 
 

Procedure:  Compile Information and Generate the Reporting Forms 
 

1. Open QuickBooks 
2. Select Reports>Vendors & Payables>1099 Summary 
3. Set the date range to “This Calendar Year”. 
4. Select “Only 1099 Vendors” and “Only 1099 Accounts” and “Ignore Thresholds” 
5. Click OK. 
6. Print the displayed report. 
7. For each vendor, compute the amount to be paid this year. 
8. Close QuickBooks 
9. On the internet, go to the EDD site: https://eddservices.edd.ca.gov/index.html and log in. 
10. Click on File Report of Independent Contractors and log into the site.  See the Appendix for 

userid and password. 
11. Select Create New DE542 and fill in the information for all new vendors for this calendar 

year or create a new DE 542 for vendors added during the calendar year. 
12. Save the draft, review the form, then save as a pdf file to Diocesan Files/Independent 

Contract Reporting/MM_DD_YYYY ICR. 
13. Select Submit and log off. 

 
End of Procedure 

  

https://eddservices.edd.ca.gov/index.html
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21 FILE A CALIFORNIA STATEMENT OF A NON-PROFIT CORPORATION 
(EVERY 2 YEARS)  

 
Purpose 
To report the names of the officers of the Diocese to the State of California and to pay the report 
fee 

 
Assumption 

• A statement must be re-filed every two years.  

• The Treasurer must file a new statement if there is a new Diocesan Secretary or Bishop.  No 
filing charge is incurred in this event. 
 

Procedure 
 

1. Go to the web site https://businessfilings.sos.ca.gov. 
2. Enter the following number in the Corporation Number field – C0733985. 
3. Select “Diocese of the West of the Orthodox Church in America”. 
4. Select “Continue Filing”. 
5. Select the “No” radio button regarding common interest development. 
6. Select “Continue”. 
7. Fill in the displayed form.  Do not use “-“ in zip code separator. 
8. Print from to the Acrobat Distiller. 
9. Select “Continue Filing” 
10. Select “proceed to Checkout” 
11. Use personal Visa Card and fill out payment info. 
12. Select “Process Order”. 
13. Print Confirmation of Receipt of Document/Receipt for Payment. 
14. Select “Return to Main Page” 
15. Exit the Internet 
 
End Procedure 
  

https://businessfilings.sos.ca.gov./
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22 PREPARE FOR EXTERNAL REVIEW OF ACCOUNTS 

 
Purpose 
To prepare the necessary items for review by internal and external auditors/reviewers. 

 
Assumptions 
 
• The external review/compilation will take place in June or July of the year following the year 

to be audited. 
• The previous year financial records have been audited by the Internal Audit Committee, 

preferably before June 1st of the following year.   
• The prior external compilations have been performed every three years by an independent 

auditor. 

• The Diocesan treasurer has created all year-end reports for the previous year.   

• The following previous year materials are ready for review: 
- A copy of the report presented to the Diocesan Assembly  
- A copy of the previous year annual report 
- Deposit and payment records for the previous year, filed by month 
- A binder with materials distributed at previous year Diocesan Council meetings, 

especially Diocesan Council meeting minutes. 
- Payroll and payroll tax records for the previous year 
- Monthly treasurer reports generated for the previous year 
- An accountant’s copy of the QuickBooks file on a CD 
- Copies of auditors’ reports for the previous year 

• The internal audit has taken place and the report had been generated.  

• An engagement letter has been written and agreed to by the external auditor and the 
Chairman of the internal Audit Committee. 

 
Procedure 
 
1. The treasurer presents the materials to the auditor.   
2. The auditor may do the following tasks in any order or may ask for additional 

information. 
3. The auditor begins with their previous year findings and determines any outstanding 

items. 
4. The auditor reviews the previous year’s final annual report. 
5. The auditor then will select monthly deposit and payment information for one or two 

months 
6. The auditor shall execute the tasks specified in the engagement letter. 
7. The auditor will prepare a management letter. 
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8. The treasurer will include the management letter with the previous-year annual report.  
These items as well as a current year-to-date financial report will be included in the 
Diocesan treasurer’s report to the Diocesan Assembly in October of the current year. 

End of Procedure 

23 APPENDIX 

23.1 Paper and Electronic Document Retention Policy 
This Document Retention Policy provides minimum guidelines for mandatory document retention 
and is intended to reduce or eliminate the possibility of accidental destruction of documents. This 
policy assumes that full, complete, and comprehensive internal audits take place on an annual 
basis.   Further, it is assumed that a more detailed definition of “important” will be developed in 
consultation with independent auditors, approved by the Diocesan Council, reviewed annually 
with independent auditors, revised as necessary, and placed as an Addendum to this Policy. Other 
documents may be added to this list as deemed appropriate by the Diocesan Council Audit 
Committee. 
A copy of this policy shall be made available on an annual basis to each employee of the Church 
administration and its departments, as well as to new employees upon hiring. 

Type of Document Minimum 
Requirement 

Location of  
Diocesan Data 

Accounts payable ledgers and schedules 7 years QB data file 
Audit reports Permanently PDF 
Bank Reconciliations 2 years PDF 
Bank statements 3 years PDF 
Checks (for important payments and purchases) Permanently QB Data File 
Contracts, mortgages, notes and leases (expired) 7 years from expiration PDF 
Contracts (still in effect) Permanently PDF 
Correspondence (general) 2 years Diocesan Office 
Correspondence (legal and important matters) Permanently Diocesan Office 
Correspondence (with customers and vendors) 2 years PDF 
Deeds, mortgages, and bills of sale Permanently PDF 
Duplicate deposit slips 2 years QB Data File 
Employment applications 3 years N/A 
Expense Analyses/expense distribution schedules 7 years N/A 
Year End Financial Statements  Permanently PDF 
Insurance Policies (expired) 3 years from expiration PDF 
Insurance records, current accident reports, claims, policies, etc. Permanently PDF 
Internal audit reports Permanently PDF 
Inventories of products, materials, and supplies 7 years N/A 
Invoices (to customers, from vendors) 7 years QB / paper 
Minute books, bylaws and charter Permanently Diocesan Office 
Payroll records and summaries 7 years QB Data File 
Personnel files (terminated employees) 7 years Diocesan Office 
Retirement and pension records Permanently N/A 
Tax returns and worksheets Permanently N/A 
Timesheets 7 years N/A 
Withholding tax statements 7 years QB Data File 
Workers’ Compensation records Permanently Diocesan Office 
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Reference: National Council of Nonprofit Associations, www.ncna.org 
 
Section 23.2 of the Appendix is found in a separate password protected file, Attachment to 
Accounting Procedures Manual. 

http://www.ncna.org/
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